
VoiceOver Getting Started with Lion
 Chapter 1. Introducing VoiceOver 
This chapter introduces VoiceOver, the advanced screen-reading technology integrated into the Mac OS X operating system. VoiceOver enables users with visual disabilities to control their computer using a rich set of keyboard commands and gestures. This chapter provides an overview of VoiceOver and key topics such as the VoiceOver cursor and current focus, keyboard shortcuts, and using function keys on some keyboards. 
About VoiceOver 
VoiceOver is a full-featured screen reader built into Mac OS X Lion that describes aloud what appears on your computer screen. VoiceOver speaks the text that's in documents and windows. To turn on VoiceOver, press Command-F5. 
When you connect a supported refreshable braille display to your computer, VoiceOver detects the display and sends it information about what's on the screen using contracted or uncontracted braille. If you're using a Multi-Touch trackpad, you can use VoiceOver gestures to navigate and interact with what's on the screen. Using VoiceOver, you control the computer primarily with a keyboard, braille display, or trackpad, instead of the mouse. 
When VoiceOver is on, you can use VoiceOver commands to navigate and interact with items on the screen. You enter VoiceOver commands by holding down the Control and Option keys together, along with one or more other keys. The Control and Option keys are called the "VoiceOver keys," or "VO keys" for short. They are shown in commands as VO—for example, to use the command VO-F1, you press Control, Option, and Fl. You can assign VoiceOver commands to numeric keypad keys, keyboard keys, braille display input keys, and trackpad gestures, so you can use the commands with fewer keystrokes. 
You use the VoiceOver cursor to move around the screen and hear descriptions of the items in the cursor. You use it to select buttons and other controls, and to read and edit text. The keyboard focus and mouse pointer work with the VoiceOver cursor in a variety of ways. You can configure them to follow each other, or use them separately to move in different applications at the same time. 
The first time you start VoiceOver, you can choose to take the Quick Start tutorial, an interactive tour of VoiceOver navigation and interaction basics. When VoiceOver is on, you can start the tutorial at any time by pressing VO-Command-F8. 
You can customize VoiceOver to best suit your needs using VoiceOver Utility. 
About the VoiceOver cursor, mouse pointer, and keyboard focus 
When you use VoiceOver to move to areas of the screen or within the text in a document, a dark rectangle is drawn around the area where VoiceOver is focused. This rectangle is called the "VoiceOver cursor." 
By default, the keyboard focus and VoiceOver cursor match, so that wherever you move the keyboard focus using standard keyboard navigation (Tab key and arrow keys), the VoiceOver cursor follows. And wherever the VoiceOver cursor goes, the keyboard focus follows (if possible). This is called "cursor tracking." You can also turn on cursor tracking for the mouse. 
�
When you open a new window, the VoiceOver cursor and the keyboard focus are positioned on the same item. For example, when you open a New Message window in Mail, the VoiceOver cursor and the keyboard focus are positioned on the To field. If you prefer, you can make the initial position of the VoiceOver cursor be on the first item in the window. 
You can turn off cursor tracking. For example, you might want to leave the keyboard focus in one place and move the VoiceOver cursor around to read a dialog that just appeared, check email messages, or perform other tasks. If you turn off cursor tracking, you can use VoiceOver commands to move the VoiceOver cursor to where the keyboard is focused when you need to. You can do the same for the mouse. 
You set preferences for the initial position of the cursor and for cursor tracking using VoiceOver Utility. 
About keyboard shortcuts and VoiceOver 
Applications use key combinations as shortcuts to help you work faster. Many shortcuts are common to all Mac OS X applications, such as Command-S for Save and Command-P for Print. You can use these keyboard shortcuts and VoiceOver commands as one way to control actions on your computer. VoiceOver commands always include the VO keys (the Control and Option keys). 
When you use VoiceOver to navigate menus, you hear the keyboard shortcut, if one exists, after the name of the menu command. For example, in the File menu, "New, Command N" means that you can use the keyboard shortcut Command-N to create a new file. 
Change the default behavior of function keys 
Function keys are located above the number keys at the top of the keyboard. On some keyboards, many of the function keys are programmed to perform hardware-related actions such as adjusting volume, muting sound, and controlling display brightness. If your keyboard has an Fn (function) key, you must press the Fn key and the function key together to use the function key for other actions. 
If you use VoiceOver all the time or very frequently, you can change the default behavior of the function keys to perform software actions. Then you have to press the Fn key only to change hardware settings, such as the volume. 
1.	    Choose Apple menu > System Preferences, click Keyboard, and then click Keyboard.
2.	    Select the "Use all Fl, F2, etc. keys as standard function keys" checkbox.Now you don't need to press the Fn key to use VoiceOver commands; you press it only when you want to use function keys to adjust hardware-related settings.
The command to turn VoiceOver on and off is Command-F5. You don't need to use the Fn key with this command. 
Some keyboards have dedicated keys for Home, End, Page Up, and Page Down. These are important VoiceOver navigation keys. If you're using a keyboard that doesn't have these keys, use the arrow keys with the Fn key for these actions. 
Chapter 2. Learning VoiceOver Basics 
This chapter provides information about the basics of using VoiceOver, including how to get help while you're learning. You'll learn how to turn VoiceOver on and off and pause it, how to hear information about items on the screen and interact with them, and how to use cursor tracking. 
Turn VoiceOver on and off 
�
log in again. 
•	     Press Command-F5. If VoiceOver is on, pressing Command-F5 turns it off.
•	     Choose Apple menu > System Preferences, click Universal Preferences, click Seeing, and then select the On or Off radio button under VoiceOver.
If you select "Show Universal Access status in the menu bar" in Universal Access preferences, you can use the status menu in the menu bar to see whether VoiceOver is on or off. 
The first time you start VoiceOver, you can choose to take the Quick Start tutorial, an interactive tour of VoiceOver navigation and interaction basics. When VoiceOver is on, you can start the tutorial at any time by pressing VO-Command-F8. 
Automatically use VoiceOver in the login window 
You can select an option in System Preferences to automatically use VoiceOver in the Mac OS X login window. 
1.	    Choose Apple menu > System Preferences, and then click Users & Groups.If Users & Groups preferences are locked, click the lock icon in the lower-left corner of the window and type an administrator password to unlock them.
2.	    In the account list, move the VoiceOver cursor to Login Options and press VO-Space bar.
3.	    In the login options, press VO-Right Arrow to navigate to the "Use VoiceOver in the login window" checkbox, and then press VO-Space bar to select it.
You can turn on VoiceOver in the login window yourself by pressing Command-F5. Pause and resume speech 
When VoiceOver is speaking, you can temporarily pause the speech, and then resume where the speaking left off. 
•	     To pause speech, press the Control key. If you're using VoiceOver gestures, tap with two fingers.
•	     To resume speech, repeat the key or gesture.
If you move the VoiceOver cursor after you pause the speech, VoiceOver begins speaking the item that's now in the VoiceOver cursor. 
Use the welcome dialog 
When you first turn on VoiceOver, a welcome dialog is displayed. 
•	     To continue using VoiceOver, press Enter or click OK.
•	     To continue using VoiceOver and prevent the welcome dialog from appearing each time you turn on VoiceOver, press V or select the "Do not show this message again" checkbox.
•	     To start the VoiceOver Quick Start tutorial, press the Space bar or click Learn VoiceOver.
•	     To turn off VoiceOver, press Command-Q, press Escape, or click Cancel.
If you chose to not display the welcome dialog again, but you change your mind and want it to be displayed, open VoiceOver Utility, click the General category, and select the "Display welcome dialog when VoiceOver starts" checkbox. 
Use the VoiceOver Help menu 
When VoiceOver is on, you can open the VoiceOver Help menu to learn more about using 
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VoiceOver and to access commands for the item in the VoiceOver cursor. 
1.	    When VoiceOver is on, open the VoiceOver Help menu by pressing VO-H.The VoiceOver menu appears on the screen. To increase or decrease the menu's font size, press the } or { key.
2.	    Navigate the menu and submenus using the arrow keys.
•	     If you know the name of a menu item, type some letters of its name to narrow the menu to only items that contain those letters. To list all the items again, press the Delete key.
•	     You hear the number of items a submenu contains when you enter the submenu.
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•	     If a menu item has a keyboard command, you hear it announced with the name of the item. Next time, you can use the keyboard command without having to open the VoiceOver Help menu. For example, to directly access the Commands menu, you can press VOH-H.
•	     To copy a menu item, select it and press Command-C. VoiceOver confirms the item was copied. You can then paste the item where needed.
3.   To select a menu item, press the Space bar or the Return key. To close the 
VoiceOver Help menu without making a selection, press the Escape key. 
Find commands using the Commands menu 
If you know the name of a VoiceOver command you want to use but can't recall the keys to press, you can use the Commands menu to find the command, and apply it to the item currently in the VoiceOver cursor. 
1.	   When VoiceOver is on, open the Commands menu by pressing VO-H-H.
2.	   Type some letters of the command name to narrow the Commands menu to just those commands that contain the letters you typed. Use the arrow keys to navigate the Commands menu until you hear the command you want. To list all commands again, press Delete.
3.	   When you hear the command you want to use, press the Return key or the Space bar to apply the command to the item in the VoiceOver cursor.
4.	 
Lock and unlock the VO keys 
VoiceOver commands are entered by pressing the Control and Option keys (the VO keys) with function keys, arrow keys, and other keys. For example, to open the VoiceOver Help menu, press VO-H. 
For convenience, you can lock the VO keys so you don't have to press them while entering commands; all you need to press are the remaining keys for the command. For example, when the VO keys are locked, you can press H alone to open the VoiceOver Help menu. 
•	     To lock the keys, press VO-;.
•	     To unlock the keys, press the command again.
If you're not familiar with the location of special keys on your keyboard, use keyboard hel p 
Learn keys, shortcuts, and gestures with keyboard help 
Make VoiceOver Ignore the next key press 
Some applications use the Control and Option keys (the VO keys) together with another key to perform an action. If you're using VoiceOver and want to use the application's command, 
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you can type a command that tells VoiceOver to ignore the next key combination. Press VO-Tab. VoiceOver will ignore the next key combination you press. 
You can change many keyboard shortcuts for Mac OS X applications and other applications in the Keyboard Shortcuts pane of Keyboard preferences. 
Learn keys, shortcuts, and gestures with keyboard help 
Using keyboard help, you can press any key to hear its name, or type any keyboard shortcut to hear the VoiceOver command it represents. You can also use keyboard help for help with: 
•	     Commanders, such as the NumPad Commander: learn the commands that have been assigned to keys.
•	     A refreshable braille display: learn the display's key names and their associated commands.
•	     VoiceOver gestures: use any VoiceOver gesture to learn its name and the VoiceOver command it represents.
While you're using keyboard help, you can't use your keyboard, braille display, or trackpad for other tasks. 
Start keyboard help 
With VoiceOver on, press VO-K. 
Hear the name of a keyboard or braille key 
Press the key. For example, press the D key to hear "d." 
Hear the VoiceOver command for a key 
Press Control-Option and the key. For example, press Control-Option-D to hear "ControlOption-D Go to Dock Moves VoiceOver cursor to the Dock." 
Hear the name and VoiceOver command for a gesture 
Use the gesture. For example, double-tap to hear "Double Tap Perform Action for Item Performs the default action on the item in the VoiceOver cursor." 
Hear alternative functions for a key or gesture 
Some keys and gestures perform alternative functions when you press modifier keys such as Shift, Control, Option, or Command. 
For keys, try pressing Control-Option with a modifier key and then press a key to hear what other functions the key may have. 
Quit keyboard help 
Press the Escape key, located in the upper-left corner of the keyboard. 
If you have trouble using your computer's standard QWERTY keyboard, you can switch the keyboard to Dvorak layout, which optimizes key layout for typing comfort and ease of use. If you have difficulty pressing more than one key at a time, you can turn on Sticky Keys to help you use a combination of modifier keys as a sequence. 
Learn VoiceOver sound effects 
In addition to the set of sounds used in Mac OS X, VoiceOver uses a variety of unique sound effects to denote events (such as a window opening) and locations (such as when you reach a border). You can listen to a description of the sounds to help you learn their meanings. 
1.   Open the VoiceOver Help menu by pressing VO-H. 
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Z.  Navigate down the menu to Sounds Help and then press the Right Arrow key. 
1.	   Use the Down Arrow and Up Arrow keys to navigate the list and hear each sound effect and its description.To repeat a sound effect and description, press the Space bar.
2.	   When you're done, press the Escape key to close the VoiceOver menu.
Hear hints and information about an item 
VoiceOver provides several ways to learn more about the item in the VoiceOver cursor. 
•	     To hear a description of the item, press VO-F3. If you're using VoiceOver gestures, tap the trackpad three times. If there is no item in the VoiceOver cursor, VoiceOver plays a sound effect to denote a blank area.
•	     Learn VoiceOver sound effects
•	     To hear the item's help tag (sometimes called a "tooltip"), press VOShift-H. If an item doesn't have a help tag, VoiceOver tells you.You can hear help tags automatically without pressing a command. In VoiceOver Utility, display the Hints pane of the Verbosity category and select Speak Help Tag from the "When an item has a help tag" pop-up menu.
•	     To hear instructions about using the item, press VO-Shift-N. You can hear instructions automatically without pressing a command. In VoiceOver Utility, display the Hints pane of the Verbosity category and select the "Speak instructions for using the item in the VoiceOver cursor" checkbox.
Descriptions, help tags, and instructions are displayed in the caption panel and braille panel, if the panels are open. 
A webpage can contain keyboard shortcuts, called "access keys," to web items such as links or buttons. VoiceOver detects access keys and can describe them (if you chose to have help tags spoken). For example, when VoiceOver detects an access key on a link, it might say "Access key available: s," where "s" is the access key. You can then press Control-S to open the link. 
Hear about items using function keys 
You can use the Fl through F6 keys with the VO keys (the Control and Option keys) to hear information about items on which the VoiceOver cursor, keyboard, or mouse pointer is focused. 
PRESS 
TO HEAR 
VO-Fl 
The application summary, describing the application that is currently active and the number of other applications that are open. 
VO-FZ 
The window summary, describing the active window. 
VO-F3 
The item on which the VoiceOver cursor is focused. The description includes the current state of the item, such as whether a checkbox is selected, or the percent value of a slider. 
If you're using VoiceOver gestures, tap three times to hear the item in the VoiceOver cursor. If there is no item, a sound effect indicates a blank area on the screen. VO-Command-F3 
The size of the item in the VoiceOver cursor. 
VO-Command-F3-F3 
The position of the item in the VoiceOver cursor. 
VO-F4 
The item on which the keyboard is focused. The description includes the current state of 
�
the item. 
VO-F4-F4 
The location of the insertion point relative to the upper-left corner of the text item in which the insertion point is located. For example, you might hear "Insertion point is two inches right, five inches down from top-left corner of edit text." 
VO-F5 
The item on which the mouse pointer is focused. The description includes the current state of the item. 
VO-F5-F5 
The location of the mouse pointer as x and y coordinates on the screen, relative to the upper-left corner of the screen. 
VO-F5-F5-F5 
The location of the mouse pointer as x and y coordinates relative to the current window. VO-F6 
The item that is currently selected (such as a folder or text in a document). 
You can also use positional audio to hear sound effects to help locate the VoiceOver cursor on the screen. 
Hear an item's location on the screen 
Hear an item's location on the screen 
If you have stereo headphones or dual speakers, you can use positional audio to hear audio cues (or sound effects) about an item's location on the screen. This option is on by default. 
1.	   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	   Click Sound in the category table, and then select the "Enable positional audio" checkbox.
If you have chosen to play stereo audio as mono audio in Universal Access preferences, you can't hear positional audio using VoiceOver. 
You can hear the position of the item on the screen by pressing VO-Command-F3-F3. Hear changes in progress or status 
You can hear when the progress bar or status text in the VoiceOver cursor changes. For example, while installing software, you might hear "Installation 45 percent completed" or you might hear a ticking sound. 
Using a VoiceOver command (for status text only) 
1.	   To open the rotor to verbosity settings, press VO-V.These settings include typing echo, punctuation, and text attributes, among others.
2.	   Press the Left Arrow or Right Arrow key until you hear "when status changes." You also hear the current setting.
3.	   Press the Up Arrow or Down Arrow key until you hear the setting you want: Play Tone, Speak, or Do Nothing.
4.	   To close the rotor, press Escape.
Using VoiceOver Utility 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Verbosity in the category table, and then click Announcements.
3.	    Select options for status text and progress indicator changes.For a description of the options, click the Help button in the lower-right corner. If you're using portable preferences on a guest computer when you change settings, the settings are saved to the portable preferences drive and not to the guest computer.
Interact with content areas 
Windows, documents, and webpages have different areas that contain text, files, or other  content. When the VoiceOver cursor reaches one of these areas, it identifies the content 
�
area. For example, VoiceOver may identify scroll areas, HTML content, lists, outlines, tables, groups, or text areas. 
You can navigate past a content area or you can stop and interact with it to read its contents. For example, in a Finder window you can navigate past the sidebar to get to the view browser, or you can interact with the sidebar to open folders and files. 
You can also interact with any element that has a title or embedded text, such as a pop-up button or a Smart Address in Mail, so VoiceOver can read the element by word or by character. 
Start interacting 
Press VO-Shift-Down Arrow. If you're using VoiceOver gestures, flick right with two fingers. 
Stop interacting 
Press VO-Shift-Up Arrow. If you're using VoiceOver gestures, flick left with two fingers. 
You can interact and stop interacting with an area as many times as necessary. When there's nothing more to interact with, you'll hear a sound effect. 
The VoiceOver cursor stays within the boundaries of the area you're interacting with, so you can navigate only within the area. 
Select and deselect items 
You can select and deselect a single item or multiple items. 
Select a single item 
When cursor tracking is off, press VO-Command-F4. If you're using VoiceOver gestures, double-tap. 
Select multiple items 
1.	    Interact with a list or table, and then press VO-Command-Space bar. You can now select multiple items.
2.	    For each item you want to select, navigate to the item and press VOCommand-Space bar. The item is selected.
3.	    When you're done selecting items, copy or cut the items, press the Escape key, or stop interacting with the list or table. You can no longer select multiple items. Deselect a single item
Press VO-Command-Space bar. If you're using VoiceOver gestures, double-tap. 
Deselect multiple items 
Navigate to one of the items and press VO-Command-F4. To deselect the last and current item, press VO-Command-Space bar. 
To hear the current selection at any time, press VO-F6. 
Hear when modifier keys are pressed 
You can set VoiceOver to speak the names of modifier keys (Shift, Control, Option, Command, and Fn) when you press them. Turning on this option may help you become accustomed to the location of modifier keys on your keyboard, and prevent you from making mistakes. 
1   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8. 
2   Click Verbosity in the category table, and then click Announcements. 
3   Select the "Announce when a modifier key is pressed" checkbox. 
Drag and drop items 
You can drag and drop items from one location to another using VoiceOver commands or the mouse. Both the original and destination locations must be on the screen when you start dragging the items. 
�
Using commands 
1.	   Move the VoiceOver cursor to the item you want to move and press VO-, to mark the item for drag and drop.
2.	   Move the VoiceOver cursor to the location where you want to drop the marked item.
3.	   Use one of the following commands to drop the marked item on, before, or after the location of the VoiceOver cursor:
•	     To insert the marked item on the cursor location, press VO-.
•	     To insert the marked item in front of the cursor location, press VO-<.
•	     To insert the marked item after the cursor location, press VO->. Using the mouse
You can use the mouse to drag and drop files with mouse tracking turned on or off. 
1.	   Move the VoiceOver cursor to the item you want to move.If mouse tracking is off, press VO-Command-F5 to route the VoiceOver cursor to the target location.
2.	   Verify that the mouse is on the item by pressing VO-F5.
3.	   Lock the mouse button by pressing VO-Command-Shift-Space bar.
4.	   Move the VoiceOver cursor to the target location.If mouse tracking is off, press VO-Command-F5 to route the mouse to the target location.
5.	   Verify that the mouse is on the target location by pressing VO-F5.
6.	   Unlock the mouse button by pressing VO-Command-Shift-Space bar.
Turn off cursor tracking 
The VoiceOver cursor and keyboard focus are set to follow (or "track") each other. You can turn off VoiceOver cursor tracking to work with the keyboard, mouse pointer, and insertion point independently. For example, with cursor tracking off, you can leave the keyboard focused in a document you're working on and move the VoiceOver cursor elsewhere, without losing your place in your document. 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Navigation, and then deselect these checkboxes:Keyboard focus follows VoiceOver cursor
VoiceOver cursor follows keyboard focus Insertion point follows VoiceOver cursor VoiceOver cursor follows insertion point 
1.	    From the "Mouse pointer" pop-up menu, choose "Ignores VoiceOver cursor." When you're working with cursor tracking off, you can use quick commands to move one cursor to where the other is located. Work with cursor tracking turned off To temporarily turn cursor tracking on or off while you're working, press VO-Shift-F3.
This command doesn't change the settings in VoiceOver Utility; it just switches them on or off until you press the command again. 
Work with cursor tracking turned off 
When you're working with cursor tracking off, you can use quick commands to move one cursor to where the other is located. 
•	     To move the VoiceOver cursor to the keyboard focus, press VO-Shift-F4.
•	     To move the keyboard focus to the VoiceOver cursor, press VO-Command-F4.
•	     To move the VoiceOver cursor to where the mouse pointer is focused, press VO-Shift-F5.
•	     To move the mouse pointer to where the VoiceOver cursor is focused, press VO-Command-F5.
Turn on cursor tracking for the mouse 
�
You can turn on cursor tracking for the mouse so that the focus of the mouse pointer and the VoiceOver cursor match. 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Navigation in the category table, and then choose an option from the "Mouse pointer" pop-up menu:
•	     To make the mouse pointer move with the VoiceOver cursor, choose "Follows VoiceOver cursor."
•	     To make the VoiceOver cursor follow the mouse pointer, choose "Moves VoiceOver cursor."
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Customize VoiceOver with VoiceOver Utility 
VoiceOver Utility is the application you use to customize VoiceOver settings to best suit your needs. It contains an easy-to-navigate list of categories for setting preferences and options. 
When you select a category on the left side of the VoiceOver Utility window, the options available to you appear on the right side. Some categories are organized into panes, which are listed across the top of the right side. You can navigate among the categories and panes using a mouse, the arrow keys, the View menu, keyboard shortcuts, or gestures. 
You can use commands in the menu bar to export and import preferences, set up portable preferences, and reset all or some preferences to their default settings. 
You can use the search field in the toolbar to quickly locate and go directly to a specific option. 
Open VoiceOver Utility 
Do one of the following: 
•	     Choose Apple menu > System Preferences, click Universal Access, click Seeing, and then click the VoiceOver Utility button.
•	     Turn on VoiceOver by pressing Command-F5, and then hold down the Control and Option keys (the VO keys) and press F8.
Each category or pane contains a Help button in the lower-right corner. Click the button to open VoiceOver online help and read a description of each option in that category or pane. 
Search VoiceOver Utility 
You can search VoiceOver Utility to quickly find and go to specific options, instead of navigating the various categories and panes. 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Interact with the toolbar and then, in the search field, type the option you're looking for. For example, start typing "caption" or "braille." As you type, possible matches in VoiceOver Utility are listed below the search field.
3.	    To navigate the list of search results, press VO-Down Arrow or VO-Up Arrow.For each search result, VoiceOver Utility displays the pane where the option is located and spotlights the option.
4.	    To select a result, press the Return key.
Chapter 3. Learning Mac OS X Basics 
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easier to use your computer, as well as how to work with applications and windows. About the Desktop 
The desktop is the background area of your screen. It can display icons for hard disks, CDs, and any servers connected to your computer. You can also store files and folders directly on your desktop for quick access. Using System Preferences, you can customize the appearance of your desktop and choose the types of items shown on the desktop. 
Navigate the desktop 
The desktop shows icons for everything it contains, such as your hard disk, folders, documents, and image files. When you open a folder on the desktop, a new Finder window opens automatically. 
•	     To move to the desktop, press VO-Shift-D.
•	     To quickly move to an item on the desktop, type the first letter of the item. For example, if you have a file named "travel plans" on the desktop, type "T" to move to it.
•	     To move around items on the desktop, press the arrow keys.
•	     To open the selected item on the desktop, press Command-O.
About the Finder 
The Finder is the program that manages your files, applications, disks, network connections, and devices such as printers. The Finder is always on when your computer is on, though it may be in the background if you're using another program such as Mail. To display a Finder window, click the Finder icon in the Dock (it's always the first icon in the Dock). 
The top-left corner of a Finder window contains three colored buttons used to close the window, send the window to the Dock (minimize), or change the window to its previous size (zoom). Under the buttons, along the top of the window, is a toolbar used to navigate, change the view, find items, and perform other actions. Below the toolbar, the window is split into two sections called the "sidebar" and the "view browser." 
Toolbar buttons and search field 
•	     Use the Back and Forward buttons on the left side of the toolbar to move back and forth between locations on your computer, just as you would in a web browser.
•	     Use the view buttons to choose how to display the contents of your hard disk and folders in Finder. You can choose icon, list, column, or Cover Flow view.
•	     Use the Action pop-up menu to choose commands for the item selected in the Finder window. Choices in the Action menu include New Folder, Open, Move to Trash, and Open, among others.
•	     Use the item arrangement button to organize items by name, kind, application, and other criteria.
•	     Use the search field to type a word or phrase to locate an item. Search results appear in the view browser. You can use the buttons below the search field to focus the search to a particular location.
Sidebar and view browser 
•	     Use the sidebar to display a list of items that you frequently use, including disks, servers, and folders. The list is organized into three sections: Favorites, Shared, Devices.The Favorites section has icons for the folders you use most, such as all of your files, applications, and desktop, among others. The Shared section lists shared computer and servers on your local network. The Devices section lists hard disks, external disks, DVDs, and other connected devices, such as iPods and iPhones.
•	     Use the view browser to view the contents of the folder selected in the sidebar. Use the view buttons in the toolbar to choose how to view items. Navigate the Finder
Finder windows display the items on your computer. You use VoiceOver commands or gestures 
�
to open and navigate Finder windows. You can use Finder shortcuts to work with selected files and folders. 
NOTE:The instructions below assume that cursor tracking is on, and the VoiceOver cursor and keyboard focus are tracking each other. 
About the VoiceOver cursor, mouse pointer, and keyboard focus 
Open a Finder window 
Do one of the following: 
•	     Move to the Dock by pressing VO-D or, if you're using VoiceOver gestures, double-tap near the bottom edge of the trackpad. Then navigate to the Finder, which is the first item in the Dock, and press Return.
•	     Open the Application Chooser by pressing VO-F1-F1 or, if you're using VoiceOver gestures, double-tap near the left edge of the trackpad. Choose Finder in the Application Chooser. You can also use the Mac OS X shortcut of holding down the Command key and pressing Tab repeatedly until you hear Finder.If a Finder window was open, you go to that window. Otherwise, you go to the desktop. In that case, go to the menu bar by pressing VO-M or, if you're using VoiceOver gestures, double-tapping near the top edge of the trackpad. Then use the Right Arrow key to navigate to the Finder menu.
Navigate a Finder window 
1.	    In a Finder window, press VO-Right Arrow or VO-Left Arrow to move through the window until you hear "toolbar." Interact with the toolbar.
2.	    Interact with content areas
3.	    Press VO-Right Arrow until you hear "view radio group" and then interact with that control. Press VO-Right Arrow until you hear the view you want to use. You can choose from icon, list, column, or Cover Flow view. In Cover Flow view, the browser is split horizontally into two sections. The top section shows a graphical view of each item, such as a folder icon or a preview of the first page of a document. The bottom section contains a list of the items.
4.	    When you have selected a view, stop interacting with the view radio group and the toolbar, and then press VO-Right Arrow to move through the window until you hear "sidebar."
5.	    Interact with the sidebar, and then move down the list of items in the sidebar by pressing VO-Down Arrow. When you hear the item you want, jump to it in the view browser; you can interact with it.To jump, press VO-J. If you're using VoiceOver gestures, keep a finger on the trackpad and press the Control key.
6.	    Move to and select the item you want to open, using the method for the view you're in:
7.	    Icon view: Use the arrow keys to move to the item you want.
List view: To move down the list rows, press VO-Down Arrow. To expand and collapse a folder, press VO-\. To move the VoiceOver cursor across a row and hear information about an item, press VO-Right Arrow. Or press VO-R to hear the entire row read at once. 
Column view: To move down the list until you find the folder or file you want, use the Down Arrow key. To move into subfolders, press the Right Arrow key. 
Cover Flow view: To flip through the items in the top section and move automatically through the corresponding list rows in the bottom section, press the Left Arrow or Right Arrow key. 
1.	    When you find the file or folder you want to open, use the Finder shortcut Command-0 or Command-Down Arrow to open it.VoiceOver announces when you have selected an alias or a file or folder you don't have permission to open.
Use Finder shortcuts 
�
You can use Finder shortcuts to work with selected files or folders. 
•	     To open the selected item, press Command-0 or Command-Down Arrow.
•	     To move to the parent of the selected item (such as the folder that contains a subfolder you have selected), press Command-Up Arrow.
•	     To add the selected item to the Finder sidebar, press Command-T.
•	     To add the selected item to the Dock, press Shift-Command-T. You can temporarily hide the toolbar and sidebar in a Finder window to make it easier to navigate. To hide or show the toolbar, press Option-Command-T. To hide or show the sidebar, press Option-Command-S.
About the Dock 
You use the Dock to open applications, documents, folders, and more. By default, it appears across the bottom of the screen. 
The Dock comes with icons for some applications, such as Mail and iTunes; you can add others. When you minimize a window or open an application that isn't in the Dock, its icon appears in the Dock. 
Each item in the Dock has a shortcut menu that gives you quick access to commands for that item. The shortcut menu also contains the commands "Remove from Dock" for icons that have been placed there permanently, and "Keep in Dock" for applications that are open but whose icons are only there temporarily. 
You can customize the Dock by changing its magnification, repositioning it, and more. To change Dock preferences, choose Apple menu > Dock. 
Use the Dock 
Use the Dock to open applications, documents, folders, or stacks. 
Navigate the Dock 
•	     To move the VoiceOver cursor to the Dock, press VO-D.If you're using VoiceOver gestures, double-tap near the bottom edge of the trackpad.
•	     To move in the Dock, use the arrow keys. If you're using VoiceOver gestures, you can flick or drag up, down, left, or right.
•	     You can also navigate in the Dock by typing the name of an application or folder. For example, to move to Mail, start typing its name; the VoiceOver cursor moves to the Mail icon and VoiceOver announces it.
Use items in the Dock 
•	     To move an item in the Dock, hold down the Option key and use the arrow keys to move the item. Each arrow key press moves it one place.
•	     To open an item in the Dock, press VO-Space bar. If you're using VoiceOver gestures, double-tap.
•	     To open a shortcut menu for an item in the Dock, press VO-Shift-M, and then use the arrow keys to move up and down the shortcut menu. To close the shortcut menu without making a selection, press the Escape key.
•	     To add an item to the Dock, navigate to the item in the Finder or on the desktop and then press Command-Shift-T. The item is added next to the Trash icon.
•	     To remove an item from the Dock, open its shortcut menu and choose "Remove from Dock."
Exit the Dock 
Press the Escape key. If you're using VoiceOver gestures, scrub back and forth with two fingers. 
To find out where the Dock is positioned on the screen, press VO-M to go to the Apple menu. Press VO-Down Arrow to move down the menu until you hear "Dock submenu" and then press VO-Right Arrow. Press VO-Down Arrow to move down the Dock menu until you hear the 
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location of the Dock, such as "Checkmark Position on Bottom." 
When hiding is turned on, the Dock is hidden from view until the mouse pointer is over the area where it usually appears (such as the bottom). To make the Dock visible again without moving the mouse pointer, press VO-D. 
Use Launchpad 
When you open Launchpad from the Dock, a full-screen view displays the icons for all of the applications on your Mac arranged in a grid. You can easily navigate the grid to open any application. 
1.	    Navigate to the Dock by pressing VO-D.
2.	    In the Dock, navigate to the Launchpad icon by pressing VO-Left Arrow or VO-Right Arrow.
3.	    With the Launchpad icon in the VoiceOver cursor, press VO-Space bar to open Launchpad.VoiceOver automatically interacts with the grid containing your applications.
4.	    Navigate down, up, left, and right in the grid by pressing VO and an arrow key.Depending on how many applications you have installed, Launchpad may have more than one page. To display other pages of the grid, stop interacting with the grid, navigate to the radio buttons at the bottom of the page, and then press VO-Space bar when you hear the page you want to display.
5.	    When you hear an application you want to open, press VO-Space bar.To exit Launchpad without opening an application, press Escape.
New applications downloaded from the Mac App Store automatically appear in Launchpad. 
About menus and the menu bar 
The menu bar at the top of the screen contains the Apple menu, application menus, status menus, and the Spotlight menu. 
•	     The Apple menu at the left end of the menu bar is always available. It contains commands to get information about your computer and to set system preferences, among other actions.
•	     Application menus change to match the active application but typically include File, Edit, Format, Window, and Help menus.
•	     Status menus display information and provide shortcuts to system and application settings, such as the volume slider, battery level indicator, or Universal Access menu.
•	     The Spotlight menu is at the right end of the menu bar. Use Spotlight to search your computer for documents, music, and more. You can search for an application and open it from Spotlight.
In the online help that comes with your Mac, the right angle bracket, or greater symbol, is used to describe a sequence of items in a menu. For example, to open a new Finder window, you open the File menu and choose New. This is written in instructions as "Choose File > New" and spoken by VoiceOver as "Choose File greater New" or "Choose File greater than New." If an item is contained in submenus, you hear a series of greater or greater than symbols. 
Perform a menu command's alternative action 
You can press a modifier key (such as the Option or Command key) when a menu command is selected to learn whether the command has an alternative action with that modifier, and then perform the action. 
1.   Move the VoiceOver cursor to a menu command. 
1.	�
  Hold down a modifier key.If the menu command has a different action with that modifier, VoiceOver speaks it. For example, if you choose Apple menu > About This Mac and hold down the Option key, the command changes to System Information.
2.	   To perform the alternative action, continue to hold the modifier key and press Enter or press the other required keys.
About files and folders 
Most of the information in your computer is stored in files. Files include documents, images, applications, and so on. Folders are simply a collection of files. Each file or folder is represented by an icon with its name below or to the right of the icon. You can select the text in the file's name to change it, and you can copy, move, and delete files on your computer. 
Your computer comes with some folders already set up, but you can create and delete your own folders to organize your information. Most folders and files you create are stored in a home folder with your user account name. If you have multiple user accounts on your computer, each user account has its own home folder. 
You click once on a file or folder icon to select it and twice to open it. Clicking twice quickly is called "double-clicking." If you double-click an application icon, you start the application and a window for the application opens. If you double-click a file created by an application, you automatically open the application (if it wasn't open already) and open the file. For example, if you double-click a TextEdit file on the desktop, TextEdit starts up and its icon appears in the Dock. At the same time, the document opens on the desktop. 
If you can't use a mouse to select and click, you can use VoiceOver commands instead. 
Copy folders and files 
You can copy a file or folder to another location using the Copy and Paste commands in the Finder. Copying an item doesn't remove it from its original location. 
NOTE:The instructions below assume that cursor tracking is on, and the VoiceOver cursor and keyboard focus are tracking each other. 
About the VoiceOver cursor, mouse pointer, and keyboard focus 
1.	   Open a Finder window and move to the item you want to copy.
2.	   Navigate the Finder
3.	   To copy the item, press Command-C.
4.	   Move to the folder where you want to paste the item. Don't open the folder; the VoiceOver cursor should be on the folder.
5.	   To paste the item, press Command-V.
About System Preferences 
You use System Preferences to customize your computer and choose essential system settings, such as your network configuration and Internet access. System Preferences is located in the Apple menu and has an icon in the Dock. 
You can find settings to improve accessibility in these preferences: 
•	     Universal Access preferences
•	     Displays preferences
•	     Keyboard preferences
•	     Mouse preferences
•	     Speech preferences
The easiest way to learn about the many options in System Preferences is to explore the different preference panes. Some preferences have multiple panes you access by clicking the tab buttons. Network preferences even has an "Assist me" button to help you 
�
troubleshoot connection problems. About Spotlight 
You can use Spotlight to easily find content on your computer. Spotlight is extraordinarily useful for VoiceOver users. In many cases, it may be easier to use than the Finder for opening files, folders, and applications. When you type text in the Spotlight search field, search results appear immediately in a menu below the search field. 
The more complete the word or phrase, the more refined your list of results will be. Search results are grouped by category, such as Applications, Messages, and Folders, among others. You click an item in the list to open it. 
If you don't find the item you want, you can search again or click Show All in Finder at the top of the results list. 
Spotlight search results include all the metadata inside files, including the kind of content, the author, edit history, format, size, and many more details. Depending on the search word you type, you may find thousands of results. Spotlight narrows its results to show you the best matches, but you can also browse the entire list if you want. 
You can find more information about Spotlight in Help Center on your computer. 
Click the mouse 
Generally, you select an item by pressing the VoiceOver command VO-Space bar. But if an item isn't accessible or that VoiceOver command doesn't work as expected, you can simulate a mouse click using a different VoiceOver command. 
1.	   Make sure the mouse pointer is on the item you want to click.If you didn't set the mouse pointer to follow the VoiceOver cursor (in the Navigation category of VoiceOver Utility), you must move the VoiceOver cursor to the item and then press VOCommand-F5 to place the pointer on the item.
2.	   Press VO-Shift-Space bar.
You can also use Mouse Keys, a Universal Access feature in Mac OS X, to control the mouse pointer. You can't use Mouse Keys when the NumPad Commander is enabled. 
Use sticky keys 
The Sticky Keys feature treats a series of modifier key presses as a single key combination. For example, you can press Control and then Option, and your keyboard interprets that combination as the Control and Option keys held down together. 
1.	    Choose Apple menu > System Preferences, click Universal Access, and then click Keyboard.
2.	    Select the Sticky Keys On radio button.
When you turn on Sticky Keys, you can also set options to display on the screen a symbol for each modifier key you press, and to hear a sound when a modifier key you press is accepted. Checkboxes for these options are below the Sticky Keys On and Off radio buttons. Use slow keys 
With the Slow Keys feature you can control the amount of time between when a key is pressed and when it is accepted by the keyboard. If you frequently press keys accidentally, you may want a longer delay. 
1.	    Choose Apple menu > System Preferences, click Universal Access, and then click Keyboard.
2.	    Select the On radio button for Slow Keys.
3.	    For a longer delay, move the Acceptance Delay slider to the left; for a shorter delay, move it to the right.
You can also hear audible feedback when you press keys. You hear one sound when a key is pressed and a different sound when the key is accepted. This is a good way to monitor 
�
what's happening if you can't see the screen. Select the checkbox labeled "Use click key sounds" to turn on audible feedback. 
Use the cursor control keys 
You can use the mouse, keyboard, and VoiceOver cursor to navigate to text and objects that appear on your screen. VoiceOver uses three function keys to describe the keyboard, VoiceOver cursor, and mouse pointer. 
NOTE:If your keyboard has an Fn key, press the Fn key when you press a function key. F3—VoiceOver Cursor Key 
To hear a description of the item in the VoiceOver cursor, press VO-F3. This could be a control, text in a document, an HTML content area, and more. The description includes the current state of the item. For example, you might hear that the checkbox is selected, or hear the value settings of a slider. 
F4—Keyboard Focus Key 
•	     To hear a description of the item on which the keyboard is focused, press VO-F4. The description includes the current state of the item and, if it applies, whether it is enabled or disabled.
•	     To move the VoiceOver cursor to where the keyboard is focused, press VOShift-F4. When you move the keyboard focus, the VoiceOver cursor remains where you moved it. Use this command when cursor tracking is turned off.
F5—Mouse Key 
•	     To hear a description of what is under the mouse pointer, press VO-F5.
•	     To hear the location of the mouse pointer as x and y coordinates, press VO-F5-F5. The origin point is the top-left corner of the main display, where the Apple menu is located.
•	     To hear the location of the mouse pointer in x and y coordinates relative to the current window, press VO-F5-F5-F5.
•	     To move the VoiceOver cursor to where the mouse pointer is located, press VO-Shift-F5. When you move the mouse pointer, the VoiceOver cursor remains where you moved it. Use this command when cursor tracking is turned off, or if you don't have mouse tracking options turned on in VoiceOver Utility.
•	     To move the mouse pointer to the VoiceOver cursor, press VO-Command-F5. When you move the mouse pointer again, the VoiceOver cursor does not move with it. Use this command when cursor tracking is turned off, or if you don't have mouse tracking options turned on in VoiceOver Utility.
Set the key repeat rate 
If you find that keys register more than once when you press them, you can adjust the key repeat rate. The key repeat rate and key repeat delay let you control how fast keys repeat and how long the keyboard waits before it begins to repeat a key press. If you have trouble releasing keys fast enough, you can set the delay very long or turn off the repeat. 
1   Choose Apple menu > System Preferences, click Keyboard, and then click 
Keyboard. 
1.	    To have keys repeat slowly, move the Key Repeat slider to the left; to have them repeat at a faster pace, move the slider to the right.If you tend to make mistakes when pressing keys, moving the slider to a slow setting will help minimize the number of repeated keystrokes.
2.	    To cause a longer delay between when you hold down the key and when the key begins to repeat, move the Delay Until Repeat slider to the left.To turn off key repeating completely, move the Delay Until Repeat slider all the way to the left. Use buttons and other controls
You can use VoiceOver commands or gestures to click buttons, select checkboxes, choose an 
�
item in a list or menu, and adjust sliders, steppers, and splitters. 
Make sure you know where the keyboard focus and VoiceOver cursor are located before you select an item. 
Hear about items using function keys 
•	     To select or deselect a control (such as a button, radio button, or checkbox), press VO-Space bar. If Quick Nav is on, press Up Arrow-Down Arrow. If you're using VoiceOver gestures, double-tap.
•	     To open a pop-up menu, press VO-Space bar. If Quick Nav is on, press Up Arrow-Down Arrow. If you're using VoiceOver gestures, double-tap.
•	     To adjust a slider, stepper, or splitter, press VO-Shift-Down Arrow to start interacting with the control. Then use the VO and arrow keys to increase or decrease a setting. To stop interacting with the control, press VO-Shift-Up Arrow.If you're using VoiceOver gestures, flick right with two fingers to start interacting with the slider or stepper. Then with a single finger, flick up to increase the setting or flick down to decrease the setting. To stop interacting with the control, flick left with two fingers.
Use Mission Control 
Mission Control gives you a comprehensive view of what's running on your Mac, including Dashboard, all your spaces, and all open widows, including those in full-screen view. When you need more room for your windows and documents, Mission Control lets you create new desktop spaces and quickly navigate among them. 
In Mission Control, a row of thumbnails across the top of the screen represents Dashboard, desktop spaces, and your full-screen apps. The lower part of the screen shows an Exposé view of the open windows on your desktop, grouped by application. 
1.	    Open Mission Control in Launchpad. If the Trackpad Commander is not turned on, you can swipe up on the trackpad using three fingers.
2.	    Use Launchpad
3.	    Navigate to the Spaces list or Expose windows by pressing VO-Left Arrow or VO-Right Arrow. To add a desktop, navigate to the Add Desktop button, located immediately after the Spaces List.
4.	    Interact with the Spaces list or the Expose windows by pressing VO-ShiftDown Arrow.
5.	    Select a space or window by pressing VO-Up Arrow or VO-Down Arrow until you hear the space or window you want to work with, and then press VO-Space bar.To exit Mission Control without making a selection, press Escape or swipe down with three fingers.
Take an application full screen 
In many Mac OS X applications, such as iCal or Mail, you can expand the window to fill your entire screen. 
•	     To expand to full screen, choose View > Enter Full Screen, or navigate to the upper-right corner of the application window to the full-screen button, and then press VO-Space bar.
•	     When you work full screen, the menu bar is displayed only on demand. To navigate to the menu bar to display it, press VO-M.
•	     Navigate menus
•	     To exit full screen for the current application, press VO-F2-F2 to display the Window Chooser, press the Down Arrow or Up Arrow until you hear "Exit fullscreen," and then press the Space bar.
Hear open applications and windows 
You can hear which applications and windows are open on your computer. 
•	�
    To hear which application is active and how many applications are open, press VO-F1.
•	     To hear which window is active, press VO-F2.
Switch between applications 
When you have more than one application open or more than one window open for an application, you can quickly switch to the application and window you want. Using the Application Chooser 
1.	    To open the Application Chooser, press VO-F1-F1. If you're using VoiceOver gestures, double-tap near the left edge of the trackpad.
2.	 
3.	    To navigate the list of open applications, press the Down Arrow or Up Arrow key, or flick down or up.
4.	    When you hear the application you want, press the Space bar or doubletap.If you used the VoiceOver command to open the chooser, pressing the Space bar opens a submenu that lists all open windows, dialogs, or alerts for the application. Navigate a submenu in the same way you did the list of applications.
To exit the Application Chooser without making a selection, press the Escape key. If you're using VoiceOver gestures, scrub back and forth with two fingers. 
Using the standard Mac OS X shortcut 
Hold down the Command key and press the Tab key repeatedly to cycle through the open applications. When you hear the application you want, release the keys. Press CommandShift-Tab to cycle backward. 
If you're using Spaces, you can use the Spaces shortcut Command-arrow keys to navigate your spaces. 
Switch between windows 
When you have more than one window open for an application, you can quickly switch between windows. 
Using the Window Chooser 
1.   To open the Window Chooser, press VO-F2-F2. If you're using VoiceOver 
gestures, double-tap near the right edge of the trackpad. 
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1.	    To navigate the list of open windows, press the Down Arrow or Up Arrow key, or flick down or up.
2.	    To select the window, press the Space bar or double-tap.
To exit the Window Chooser without making a selection, press the Escape key. If you're using VoiceOver gestures, scrub back and forth with two fingers. 
Using the standard Mac OS X shortcut 
Hold down the Command key and press the ' key repeatedly to cycle through the open windows for the current application. When you hear the window you want, release the keys. Press Command-Shift-' to cycle backward. 
Move a window to the front 
Sometimes the window where the VoiceOver cursor is located doesn't move to the front of the other windows. If this happens, some of the buttons and controls in the window won't be active. You can use a VoiceOver command to move a window to the front so you can use all the controls. 
Press VO-Shift-F2. 
�
Move windows and objects 
You can move windows and some objects in applications, such as graphics and text boxes. 
1.	    Navigate to the item you want to move and press either VO-' (for a window) or VO-Command-' (for an object).VoiceOver tells you if an item can't be moved.
2.	    Move the window or object in one of these ways:
•	     To move up, down, left, or right, press the arrow keys.
•	     To move diagonally, press VO with the Up or Down arrow and the Left or Right Arrow keys. For example, to move a window diagonally toward the upper-right corner, press VO-Right Arrow-Up Arrow.
•	     To move in smaller increments, press Shift while you use the arrow keys.
3.   To stop moving the window or object, press the Escape key.You can't use  other VoiceOver commands until you stop moving the item. 
You can use certain number keys to quickly move windows and objects around the screen: the top-left, middle, and right section using keys 1, 2, and 3; the center-left, middle, and right section using keys 4, 5, and 6; and the bottom-left, middle, and right section using keys 7, 8, and 9. 
Resize windows and objects 
You can resize windows and some objects in applications, such as graphics and text boxes. 
1.	    Navigate to the item you want to resize and press either VO-- (for a window) or VO-Command-- (for an object).VoiceOver tells you if an item can't be resized.
2.	    In the menu that's displayed, choose an edge, corner, or handle.
3.	    Resize the item.
•	     To resize an edge, use the VO and arrow keys (for example, press VO-Right Arrow to extend the right edge of a window or object). To resize in smaller increments, also press Shift.
•	     To resize a corner or handle, use VO and two arrow keys (for example, press VO-Right Arrow-Up Arrow to extend the top right corner of a window or the top-right handle of an object). To resize in smaller increments, also press Shift.
4.   To stop resizing the window or object, press the Escape key.You can't use 
other VoiceOver commands until you stop resizing. 
Log in to an encrypted account without VoiceOver 
You can turn on FileVault to encrypt the information on your disk and protect it from unauthorized access. After your disk is encrypted, you must log in to your account whenever your computer is restarted or wakes from sleep. VoiceOver and Mac OS X speech services aren't available in the login window. Instead, a series of beeps indicates in which field of the login window the cursor is positioned. 
1.	   After your Mac awakes or starts, determine if the login window is  displayed by pressing Command-F5.If you hear a single beep, the cursor is positioned in the Name field and you can begin logging in. Continue to step Z.
If you don't hear a single beep, the login window might not be displayed yet. Wait a minute and then press Command-F5 again. If you still don't hear a beep, there may be a problem with encryption. Turn off your computer and then turn it on again. An unecrypted login process will begin and you can log in with VoiceOver available. 
1.	   Type your account name and press Return.If you hear a double beep, you  entered a valid account name. Continue to step 3.
If you hear a single beep, you entered an invalid account name and the cursor remains in the Name field. Keep entering your account name until you hear a double beep. 
1.	   Type your account password and press Return.If you hear three beeps, you  entered a valid password and login proceeds.
If you hear a double beep, you entered an invalid password and the cursor remains in the 
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Password field. Keep entering your password until you hear three beeps. Chapter 4. Working with Text 
Text is found in many places on your computer, such as in windows and dialogs, in content areas like webpages and help files, and in documents. This chapter explains how to use VoiceOver to read, select, and edit text. 
Read text 
VoiceOver provides many ways to read text. You can read text a word, line, sentence, or paragraph at a time. You can hear words and characters spelled phonetically. 
As you read, you can pause and resume speaking by pressing the Control key. If you're using VoiceOver gestures, tap two fingers. 
Using VoiceOver commands 
•	     To read an entire document from the top (called "Read All") without interacting with the document, press VO-A.
•	     When you're interacting with a document, to read from the VoiceOver cursor to the bottom of the text area, press VO-A.
•	     To read a line, press VO-L. To move to the next or previous line, press VO-Down Arrow or VO-Up Arrow.
•	     To read a paragraph, press VO-P. To move to the next or previous paragraph, press VO-Shift-Page Down or VO-Shift-Page Up.
•	     To read a sentence, press VO-S. To move to the next or previous sentence, press VO-Command-Page Down or VO-Command-Page Up.
•	     To read a word, press VO-W. To hear the word spelled, press VO-W again. To hear it spelled phonetically, press VO-W again. To move to the next or previous word, press VO-Right Arrow or VO-Left Arrow.
•	     To read a character, press VO-C. To hear the character spoken phonetically, press VO-C again. To move to the next or previous character, press VO-ShiftRight Arrow or VO-Shift-Left Arrow.If you selected the "Use phonetics" checkbox in the Announcements pane of VoiceOver Utility, characters are automatically read phonetically. For example, VoiceOver reads "a alpha n november t tango."
• 
Using VoiceOver gestures 
•	     To read an entire document starting from the top (called "Read All"), flick up with two fingers.
•	     To read from the VoiceOver cursor to the bottom of the text area, flick down with two fingers.
•	     To read a word, line, sentence, or paragraph at a time, press the Command key while touching a finger on the trackpad; repeat until you hear the setting you want to use
When you use the Down Arrow key to move from one line of text to the next, VoiceOver speaks the line where the insertion point is located. Consequently, if you press the Down Arrow key at the first line of a document, VoiceOver won't read the line because the insertion point has moved to the next line. To hear the first line of text in a document, press VO-Down Arrow. 
When VoiceOver reads text on a webpage, it indicates internal links (links within the current webpage) if the verbosity level for links is set to high in VoiceOver Utility. 
�
When more content is available than can be displayed at one time in a window, you can scroll to the "hidden" content. You can use a VoiceOver command or VoiceOver gestures to scroll content without first interacting with the content. 
Using a VoiceOver command 
1   Interact with a scroll area. 
2   Interact with content areas 
3   To begin scrolling, press VO-Shift-S.You can't use other VoiceOver 
commands while you're scrolling. 
1.	    Scroll the content.To scroll up and down or left and right, press the arrow keys.
To scroll one page at a time, press the Page Up or Page Down key to scroll vertically, and press Shift-Page Up or Shift-Page Down to scroll horizontally. 
VoiceOver plays a sound effect when you can't scroll farther in a particular direction. 
1.	    To stop scrolling, press the Escape key.
Using VoiceOver gestures 
•	     To hear the number of pages or rows that are visible on the current page, tap three fingers. VoiceOver speaks something like "Page 4 of 15 and Horizontal page 1 of
2." 
•	     To scroll one page at a time, flick up, down, left, or right with three fingers.
•	     In the Trackpad Commander pane of VoiceOver Utility, you can select a checkbox to scroll the content (not the scroll bar) down or up. Normally when you move the scroll bar down or up, the content moves in the opposite direction. When the option is selected, the content moves in the same direction you're scrolling.
When you interact with content, the VoiceOver cursor automatically scrolls as it navigates the content. 
Hear misspelled words in text 
VoiceOver can alert you when it encounters a misspelled word in text. 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Verbosity in the category table, and then click Text.
3.	    From the "When encountering a misspelled word" pop-up menu, choose an option: Do Nothing, Play Tone, Speak Attributes, or Change Pitch.
Hear punctuation 
You can change the amount of punctuation you hear, from none to all. 
All: Hear all special symbols and punctuation except for spaces. VoiceOver reads a sentence like this, "She turned and stopped comma then started walking again period" Most: Hear all special symbols but not common punctuation, such as the comma and period. Some: Hear keyboard symbols and many math symbols, such as + (plus) sign. 
None: Hear text as you would normally read it, with pauses for commas and periods. 
Using a VoiceOver command 
1.	    To open the rotor to verbosity settings, press VO-V.Verbosity settings include typing echo, punctuation, and text attributes, among others.
2.	    Press the Left Arrow or Right Arrow key until you hear "punctuation." You also hear the current setting.
3.	    Press the Up Arrow or Down Arrow key until you hear the setting you want.
4.	    To close the rotor, press Escape.
Using VoiceOver Utility 
1.	�
   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Verbosity in the category table, and then click Text.
3.	    Move the VoiceOver cursor to the Punctuation pop-up menu and press the Space bar.
4.	    Press the Up Arrow or Down Arrow key until you hear the setting you want and then press the Space bar.
If you're using portable preferences on a guest computer when you change settings, the settings are saved to the portable preferences drive and not to the guest computer. 
Hear text attribute changes 
You can change how VoiceOver announces changes in text attributes. VoiceOver can play a tone, speak the attribute, or do nothing. 
Using a VoiceOver command 
1.	    To open the rotor to verbosity settings, press VO-V.These settings include typing echo, punctuation, and text attributes, among others.
2.	    Press the Left Arrow or Right Arrow key until you hear "text attributes." You also hear the current setting.
3.	    Press the Up Arrow or Down Arrow key until you hear the setting you want.
4.	    To close the rotor, press Escape.
Using VoiceOver Utility 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Verbosity in the category table, and then click Text.
3.	    Move the VoiceOver cursor to the "When text attributes change" pop-up menu and press VO-Space bar.
4.	    Press the Up Arrow or Down Arrow key until you hear the setting you want, and then press the Space bar.
To hear details about the text style closest to the VoiceOver cursor, press VO-T. 
If you're using portable preferences on a guest computer when you change settings, the settings are saved to the portable preferences drive and not to the guest computer. 
Hear text in dialogs 
You can control how much description you hear in dialogs. By default, you hear all of the text. 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Verbosity in the category table, and then click Announcements.
3.	    Do one of the following:
To hear all of the text in dialogs, such as labels, select the "Automatically speak text in dialog boxes" checkbox. 
o   To hear only the text to which the VoiceOver cursor moves when the dialog 
opens, deselect the checkbox. 
Hear the current selection 
In the Finder and other applications, you must first select the item you want to use. For example, if you want to open a folder, you must first select the folder. You can use a VoiceOver command to quickly find out what, if anything, is currently selected. 
Press VO-F6. If you're using VoiceOver gestures, tap three times. 
If nothing is selected, you hear "No selection available." If text is selected, you hear the text. 
�
Repeat or save the last spoken phrase 
If you couldn't clearly hear what VoiceOver said, you can repeat the last spoken phrase. You can also save it as an audio file on your desktop. 
Repeat the phrase Press VO-Z. 
Save the phrase 
Press VO-Shift-Z. 
An archive folder containing the audio file is saved. This folder also contains log files, which contain a record of the actions that occurred on your computer, and can be used to troubleshoot computer problems. 
You can also copy the last spoken phrase to the Clipboard (also called the "Pasteboard") by pressing VO-Shift-C. 
Select text 
You can use standard Mac OS X keyboard shortcuts to select text. 
NOTE:You must have set the keyboard focus and the VoiceOver cursor to track each other in VoiceOver Utility. You can turn cursor tracking on and off whenever you want. 
Turn off cursor tracking 
•	     To select the character to the right or left of the insertion point, press Shift-Right Arrow or Shift-Left Arrow.
•	     To select the word to the right or left of the insertion point, press Shift-Option-Right Arrow or Shift-Option-Left Arrow.
•	     To select the text from the keyboard cursor to the beginning or to the end of the line, press Shift-Command-Right Arrow or Shift-Command-Left Arrow.
•	     To select the text from the keyboard cursor to the beginning or to the end of the text area, press Shift-Command-Up Arrow or Shift-Command-Down Arrow.
You can delete selected text by pressing the Delete key. If you accidentally delete text, you can often use the keyboard shortcut Command-Z to undo the mistake. This shortcut works only if you use it immediately after the mistake. 
If you can't select text using standard Mac OS X keyboard shortcuts, as in an email message that you have received, press VO-Return. Then press VO-arrow keys to read the text you want to select, and then press VO-Return again. The text that was read is highlighted and selected. 
Hear what you type 
VoiceOver can speak what you're typing. This is known as a "typing echo" and is useful if you want to hear confirmation of what you've typed. You can change the level of typing echo you hear using a keyboard command or VoiceOver Utility. Choose from these settings: Nothing: VoiceOver doesn't speak what you type. 
Characters: VoiceOver speaks each character as you type it. 
Words: VoiceOver speaks the word you typed after a brief pause (the default setting). Characters and Words: VoiceOver speaks each character and completed word. 
Using a VoiceOver command 
1.   To open the rotor to verbosity settings, press VO-V.Verbosity settings 
include punctuation, misspelled words, and text attributes, among others. 
1.	�
   Press the Left Arrow or Right Arrow key until you hear "typing echo." You also hear the current setting.
2.	    Press the Up Arrow or Down Arrow key until you hear the setting you want.
3.	    To close the rotor, press Escape.
Using VoiceOver Utility 
1.   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8. 
Z.   Click Verbosity in the category table, and then click Text. 
1.	    Move the VoiceOver cursor to the "While typing speak" pop-up menu and press VO-Space bar.
2.	    Press the Up Arrow or Down Arrow key until you hear the setting you want, and then press the Space bar.For more information about the options, click the Help button in the lower-right corner of the pane.
If you're using portable preferences on a guest computer when you change settings, the settings are saved to the portable preferences drive and not to the guest computer. 
Hear when caps lock is on 
VoiceOver plays a tone whenever you type an uppercase character, to let you know it's  uppercase. You can also have VoiceOver announce when the Caps Lock key is on and off. 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Verbosity in the category table, and then click Announcements.
3.	    Select the "Announce when the Caps Lock key is pressed" checkbox. Complete partially entered words
Some applications, such as TextEdit, can display a list of possible words to complete partially entered text. For example, you can type "cow" and then display a list of words that start with "cow," so you can pick a word from the list. You can use VoiceOver to review the list and select a word from it. 
1.	   As you type, enter as many characters as you know, and then press F5 (do not use the VO keys with this command). You may need to press Fn-F5.
2.	   Press the Down Arrow key until you hear a word that sounds correct.
3.	   To hear how the word is spelled, press VO-W-W. To hear the word spelled  phonetically, press VO-W-W-W.
4.	   When you hear the word you want to use, press the Space bar.The word you  selected replaces the text you typed.
Correct misspelled words 
Many Mac OS X applications, such as TextEdit and Mail, can identify misspelled words as you type and suggest correctly spelled versions of the words. You can let a misspelled word be automatically corrected, or you can review the suggestions and choose a correction. 
If you don't want spelling to be corrected automatically, choose Edit > Spelling and Grammar, and then deselect the Correct Spelling Automatically command. This command is not available in all applications. 
Use automatic spelling correction 
When VoiceOver announces a misspelled word as you're typing, do one of the following: 
•	     To let the word be automatically corrected, keep typing. If the spell checker can't find a valid correction, it underlines the misspelled word in red. You can check the document to manually correct these misspellings.
•	     To choose a suggested correction, press the Down Arrow key, and then press the Left Arrow or Right Arrow key until you hear the suggestion you want to use. Then press Return. To exit the suggestions without choosing one, press Escape or the Up Arrow
�
key. 
•	    If at any time while working in the document you decide you want to use the original spelling of a word that was automatically corrected, navigate to the word and position the insertion point just after the word, and then revert the correction.
Correct spelling manually 
If you've chosen not to use automatic spelling correction, or a document contains misspelled words for which the spell checker couldn't suggest a correction, you can review and correct misspellings manually. 
1.	    To navigate to the first misspelled word, press Command-;.If you need to interact with the text area first, press VO-Shift-Down Arrow.
2.	    To hear the word spelled, press VO-W-W.Sometimes words that the computer doesn't recognize are underlined, but they're not actually misspelled. Continue pressing Command-; until you hear a word that needs to be corrected.
3.	    To open a shortcut menu of suggested spellings, available dictionaries, and more, press VO-Shift-M.
4.	    Use the arrow keys to navigate to the spelling you want to use, and then press VO-Space bar to select it.If you choose a corrected spelling from the menu, the new spelling replaces the old one. If you don't hear an acceptable correction, press Escape to close the menu, press VO-Shift-F4 to move the VoiceOver cursor to the misspelled word, and then edit the word manually.
You can use the Spelling and Grammar window, found in the Edit menu in most applications, to check spelling and grammar. To display the window, press Command-Shift-:. 
Chapter 5. Navigating Content 
VoiceOver provides numerous ways to navigate content and text. In this chapter, you'll learn how to navigate content such as tables and text, and how to use navigation features such as Quick Nov, the Item Chooser, and hot spots, among others. 
Navigate menus 
The menu bar at the top of the screen contains three main areas: the Apple and application menus, status menus, and the Spotlight menu. 
Navigate to the menu bar 
Press VO-M. 
If you're using VoiceOver gestures, double-tap with two fingers near the top edge of the trackpad. 
Navigate in the menu bar 
•	     To jump from one area (such as status menus) to another (such as the Spotlight menu), press VO-M. To move between menus in an area, press VO-Right Arrow or VOLeft Arrow. You hear a sound effect when you are at the last menu in an area.
•	     If you're using VoiceOver gestures, drag a finger across the trackpad to navigate the areas and menus in the menu bar. You hear a sound effect when moving over a blank space. You can also flick left or right to move between menus.
•	     To quickly move to a menu, type the first letter of the menu. For example, type "H" to move to the Help menu.
•	�
    To move down or up a menu, press VO-Down Arrow or VO-Up Arrow. If you're using VoiceOver gestures, drag a finger down or up.
•	     To move to a submenu, press VO-Right Arrow. To return to the main menu, press VO-Left Arrow. If you're using VoiceOver gestures, flick right or left.
Close a menu 
To exit a menu without selecting an item, press Escape. If you're using VoiceOver gestures, scrub back and forth with two fingers. 
Shortcut menus give you quick access to commands so you don't have to navigate to the menu bar. To open a shortcut menu for an item, press VO-Shift-M. If you're using VoiceOver gestures, you can use the customized gesture Control-Trackpad click (you can change this default assignment and assign the command to a different gesture). 
Many menu items have keyboard shortcuts you can use to bypass menus altogether. For example, to open the Print window, press Command-P, instead of navigating to File > Print. 
Navigate tables 
You can navigate tables in text areas by row and column, and sort by column. 
•	     To hear the column header, press VO-C.
•	     To hear the contents of a table row from the location of the VoiceOver cursor to the end of the row, press VO-R.
•	     To hear the contents of a table column from the location of the VoiceOver cursor to the bottom of the column, press VO-C-C.
•	     To sort the column, position the VoiceOver cursor on the column and press VO-I.
•	     To move up or down in a column, press the Up Arrow or Down Arrow key.
•	     To jump to the parent level of the current cell in an outline view, press VO-Command-\.
You can use the same text commands you would use for documents to read text in a table. When you're interacting with a table, VoiceOver doesn't announce blank columns as you navigate using the arrow keys unless you have the verbosity level for tables set to High. Customize the verbosity level for speech or braille 
You can choose to have VoiceOver read the header text when it navigates a table row. This setting is useful for identifying the type of content in each cell of a row. To set this option in VoiceOver Utility, choose Verbosity in the category table, click Announcements, and then select the "Speak header when navigating across a table row" checkbox. 
Navigate by finding text or letters 
You can navigate by searching for specific text or a specific letter. 
By text 
For example, if you're working in a TextEdit document and you want to find the next occurrence of "braille," type braille in the VoiceOver search panel and the VoiceOver cursor will move directly to the next occurrence. 
1.	    Press VO-F.VoiceOver displays a search panel.
2.	    In the search panel, type or paste (by pressing Command-V) the text you're looking for, and then press Return.VoiceOver searches from the VoiceOver cursor to the end of the text area.
•	     To find the next occurrence of the text in the window, press VO-G.
•	     To find the previous occurrence of the text in the window, press VO-Shift-
•	�
    To review past searches, press the Up Arrow or Down Arrow key. Before you repeat, delete, or enter a new search, press VO-F.
To repeat a previous search, press Command-A. 
•	     To delete a search, press Command-Delete.
By letter 
For example, you can use fast searching to quickly move to the next occurrence of the letter S in an element on the screen. 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Navigation in the category table, select the "Enable fast searching" checkbox, and choose whether to use the Left Command or the Right Command key when fast searching.
3.	    Search for the next or previous element that begins with a specific letter.
•	     To search for the next element, press the Left Command or Right Command key and the letter. For example, press Left Command-S.
•	     To search for the previous element, press the Left Command or Right Command key, the Shift key, and the letter. For example, press Left Command-Shift-S. Navigate using text attributes
You can navigate in a document by searching for text attributes, such as a bold font or a change in font color. 
•	     To find the next instance of the specified attribute, press the keys indicated:
•	     Bold text: VO-Command-B
Font change: VO-Command-O 
Text that has the same style as the current text: VO-Command-S (if you are not in a text area, VO-Command-S finds the next item that is the same as the current item) 
Style change: VO-Command-C 
Italic text: VO-Command-I 
Color change: VO-Command-K 
Underlined text: VO-Command-U 
Plain text: VO-Command-P 
Graphic: VO-Command-G 
Link: VO-Command-L 
•	     To find the previous instance of an attribute, use the same commands listed above with the Shift key, as in VO-Command-Shift-B or VO-Command-Shift-L.
Navigate using cursor wrapping 
When you use cursor wrapping, VoiceOver treats the items in a window or column as a continuous loop. For example, if you're at the top of a window and move back, you go to the last item in the window. You hear audible cues when you wrap. 
If you turn on cursor wrapping in VoiceOver Utility, VoiceOver wraps automatically. You can also use cursor wrapping only when you choose. 
Wrap automatically 
1.   When VoiceOver is on, open VoiceOver Utility, click Navigation, and then 
select the "Allow cursor wrapping" checkbox. 
Z.   To use wrapping, do any of the following: 
1.   To wrap from the last item in a window to the top of the window, press VO- 
Right Arrow. 
Z.   To wrap from the first item in a window to the bottom of the window, press 
VO-Left Arrow. 
3.   To wrap from an item at the bottom of a column (such as a list) to the 
first item in the next column, press VO-Down Arrow. 
4.   To wrap from an item at the top of a column (such as a list) to the last 
�
item in the previous column, press VO-Up Arrow. 
Wrap only when you choose 
•	     To wrap from the last item in a window to the top of the window, press VOCommand-Shift-Right Arrow.
•	     To wrap from the first item in a window to the bottom of the window, press VO-Command-Shift-Left Arrow.
•	     To wrap from an item at the bottom of a column to the first item in the next column, press VO-Command-Shift-Down Arrow.
•	     To wrap from an item at the top of a column to the last item in the previous column, press VO-Command-Shift-Up Arrow.
Navigate using the Tab key 
Mac OS X includes full keyboard access, which lets you use the Tab and arrow keys to move the keyboard focus to text boxes, lists, radio buttons, checkboxes, and other controls. When you navigate using the Tab key while VoiceOver is on, keep these points in mind: 
•	     The Tab key may not move to all controls, like the VoiceOver cursor does. The Tab key may move only to text boxes and lists, depending on the option you've selected in the Keyboard Shortcuts pane of Keyboard preferences (or if you've pressed Control-F7 to change this option while working).
•	     When you use the Tab key to navigate and the VoiceOver cursor lands on an item, you immediately interact with the item (you don't need to enter a command to interact with it). For example, when you navigate to the mailbox list in Mail, you can automatically interact with the mailboxes. You can turn off this automatic interaction in the Navigation category in VoiceOver Utility.
•	     To navigate in reverse, press Shift-Tab.
Navigate using Quick Nav 
With Quick Nay, you can navigate webpages and applications using only the arrow keys, and navigate webpages using single keys. 
Turn Quick Nav on or off 
Press the Left and Right arrow keys at the same time. 
If you deselected the option to toggle Quick Nav using the arrow keys in the Quick Nav Commander in VoiceOver Utility, this command won't work. Instead, press VO-H-H to open the Commands menu, type "quick" to search for the "Toggle Quick Nav On or Off" command, and then select it. 
Navigate applications and webpages using arrows 
•	     To move left, right, up, or down, press an arrow key. With Quick Nav,
these keys function the same as pressing the VO-arrow keys. 
•	     To start interacting with an item, press the Right and Down arrow keys together.
•	     To stop interacting with an item, press the Left and Down arrow keys together.
•	     To perform the default action on the item in the VoiceOver cursor, press the Down and Up arrow keys together.
Navigate webpages using single keys 
If you enabled single-key webpage navigation in the Quick Nav Commander in VoiceOver Utility, you can use single keys to navigate webpages. For example, press b or B to navigate to the next or previous button, or 1 or ! to navigate to the next or previous Heading 1. 
�
Use the Quick Nay Commander in VoiceOver Utility to change the default single-key assignments, and add your own key assignments. 
Navigate applications and webpages using the rotor 
You can use Quick Nay with the Web rotor. 
•	     To open the Web rotor, press Left Arrow-Up Arrow or Right Arrow-Up Arrow.
•	     To jump to the next list in the Web rotor, press the Right and Up arrow keys together.
•	     To jump to the previous list in the Web rotor, press the Left and Up arrow keys together.
•	     To navigate the items displayed in a list in the Web rotor, press the Up Arrow or Down Arrow.
When Quick Nov is on, the Quick Nov arrow and single-key commands are included in the Commands menu. To display the Commands menu, press VO-H-H. 
Find commands using the Commands menu 
Navigate using the Item Chooser 
You can use the Item Chooser to quickly go to any item on the screen or in a window. The Item Chooser menu lists text, controls, links, and graphics. 
1.	    To display the Item Chooser, press VO-I.
2.	    Navigate the items in the list using the Up Arrow or Down Arrow key until you find the item you want.
o   If you know the name of an item, such as the Close button, start typing 
its name to narrow the list to only items that contain those letters. To list all the items again, press the Delete key. 
o   If you don't find the item you want, press the Escape key to exit the Item 
Chooser without making a selection. 
1.	    Press Return or the Space bar to select the item and go to it.The Item Chooser closes.
Monitor items with hot spots 
You can use hot spots to monitor items and jump to those items at any time. After you set a hot spot for an item, you can use the hot spot until you close the window that contains the item. If you turn off VoiceOver and then later turn it on, hot spots you set are still available. 
You can set up to ten hot spots; if you use VoiceOver activities, you can set up to ten hot spots for each activity. 
Set a hot spot 
Navigate to the item and press VO-Shift-[number key]. 
If you assign a number that's already being used in a hot spot, the new hot spot replaces the old one. 
Remove a hot spot 
Press VO-Shift-[number key] on the hot spot. 
For example, if you set a hot spot on the first icon in the Dock (by pressing VO-Shift-5), you would press VO-5 to jump to that hot spot, and then press VO-Shift-5 to remove the hot spot from the icon. 
Use hot spots 
•	     To jump to a hot spot, press VO-[number key].
•	�
    To hear a description of a hot spot, press VO-Command-[number key].
•	     To watch for value changes in a hot spot, press VO-Command-Shift-[number key]
VoiceOver announces whenever the item's value changes. When you no longer want to hear value changes, press the command again. 
When you jump to hot spots in tables, lists, or web areas, you can immediately interact with those items; you don't need to enter a VoiceOver command to interact with them. 
To use the Hot Spot Chooser to browse and jump to hot spots, press any hot spot key twice. For example, you might press VO-7-7 to display the Hot Spot Chooser. The Hot Spot Chooser lists all active and inactive (those in closed applications) hot spots, and offers commands to move to the next or previous hot spot. 
You can assign hot spot commands to keys on the numeric keypad or keyboard, or on a braille display. If you're using a Multi-Touch trackpad, you can assign the commands to VoiceOver gestures. You can also assign commands to move to the next or previous hot spot. You can use hot spots on some non-English keyboards. 
Chapter 6. Browsing the Internet 
This chapter provides information about using VoiceOver to browse and navigate webpages effectively using two different navigation modes, tables, images, frames, and web spots, as well as the VoiceOver Web Item rotor. 
Ways to browse webpages 
There are several ways you can browse and navigate webpages. 
•	     You can choose a default navigation mode, by Document Object Model (DOM) or by grouping related items. You can switch between modes to use the one that works best for the current webpage.
•	     Navigate webpages using DOM or group mode
•	     You can use the Web rotor to quickly jump to links, headings, web spots, tables, and more on a webpage.
•	     Navigate webpages using the Web rotor
•	     If you're using VoiceOver gestures, you can use the web settings of the gestures rotor to navigate webpages more easily.
•	     Use rotor settings with gestures
•	     With Quick Nav, you can navigate webpages and applications using only arrow keys, or webpages using only single keys.
•	     Navigate using Quick Nav
•	     You can use auto web spots and web spots you create to scan webpages and navigate them more quickly.
•	     Navigate webpages using web spots
•	     You can hear a summary of a table and its cells as you press the arrow keys to navigate the table. You don't need to interact with the table unless you hear something that you want to explore in detail.
•	     Navigate tables on webpages
• 
Web developers can assign keyboard shortcuts, called "access keys," to webpage items such as links and buttons, to make them easier to interact with. VoiceOver can notify you when it detects access keys. For example, if VoiceOver detects an access key on a link, it might say "Access key available: s," where "s" is the access key. You can then press Control-S to open the link. To hear access keys, you must select the option to speak help tags in the Hints pane of the Verbosity category in VoiceOver Utility. 
Hear a summary of a webpage 
When you browse webpages using VoiceOver, you can hear a summary of webpage statistics 
�
that tells you how many headings, links, tables, landmarks, live regions, and more are on the page. This information can help you assess the scope and structure of the webpage and navigate in ways that best suit the webpage. 
To hear the statistics for the current webpage, press VO-Shift-I. You can set an option in the Web category in VoiceOver Utility to have the summary automatically read when a webpage opens. 
VoiceOver speaks statistics only for the items listed in the Web rotor. 
Navigate webpages using DOM or group mode 
VoiceOver provides two modes for navigating webpages: by a webpage's Document Object Model (DOM), or by grouping related items. Navigating by DOM moves left and right, in the order set by the webpage's author. (Moving up and down in DOM mode is based on the current setting of the Web Item rotor.) Navigating by group moves in any direction, to help give you a sense of context. 
You set the default web navigation mode in VoiceOver Utility, but you can easily switch modes to best suit the current webpage. 
Set the default navigation mode 
1.	   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	   Click Web in the category table, click Navigation, and then select the "DOM order" or "Grouping items" radio button.
Switch navigation modes 
Do one of the following: 
•	     Press VO-H-H to display the Commands menu, type "dom" to narrow the list of commands, and then select the "Toggle Web Navigation DOM or Group" command.
•	     In VoiceOver Utility, in the NumPad, Keyboard, or Quick Nav Commander, or the Input pane for braille displays, assign the "Toggle Web Navigation DOM or Group" command to a key. Then use that key to switch modes while navigating webpages. Navigate by DOM
To navigate list items, press VO-arrow keys (you don't need to interact with a list to navigate the list items). 
Navigate by grouping items 
To navigate the items in a list, interact with the list. You don't need to interact with groups that contain only one item. 
When you navigate to a list, VoiceOver indicates the number of items in the list and when it has reached the end of the list. 
If you're using VoiceOver gestures, the current web navigation mode affects how you navigate webpages using the rotor. If you're navigating in DOM mode, flicking up or down moves to the previous or next instance of the item that matches the current rotor setting. For example, if the rotor is set to Headings, flicking up or down moves to the previous or next heading. If you're navigating by grouping items, flicking up or down moves to the previous or next group of related items. You can assign the "Toggle Web Navigation DOM or Group" command to a gesture using the Trackpad Commander, to easily switch modes to suit your needs. 
Assign VoiceOver commands to gestures 
Navigate webpages using images 
Webpages typically contain images, some of which may be used as links. Some images include a description, called "alt text." You can navigate only to images that contain alt text, never navigate to images, or always navigate to images. 
Customize image navigation 
1.	�
  When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	   Click Web in the category table, click Navigation, and then choose an option from the Navigate Images pop-up menu.For a description of the options, click the Help button in the lower-right corner of the pane.
Navigate to images 
•	     To jump to the next or previous graphic, press VO-Command-G or VO-CommandShift-G.
•	     If images are listed in the Web rotor, you can use the rotor to move to a specific image.
•	     Navigate webpages using the Web rotor
When you navigate to an image that doesn't have a description, VoiceOver speaks the image filename. You can create a custom label for these images, or for images whose alt text isn't useful. 
Create custom labels 
If images are listed in the Web rotor, you can listen to the webpage summary to hear how many images are on the current webpage. 
Hear a summary of a webpage 
Navigate tables on webpages 
Tables are used extensively on webpages to create visual layouts and to present data. You can navigate data tables by grouping items within the tables. When you navigate tables by grouping, you hear a summary of a table and its cells as you press the arrow keys to navigate the table. You don't need to interact with the table unless you hear something that you want to explore in detail. You can use a VoiceOver command to turn grouping on or off to best suit the current table. 
Turn on grouping for all tables 
1.	   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	   Click Web in the category table, click Navigation, and then select the "Group items within" checkbox.
Turn grouping on or off for the current table 
Press VO-=. 
Only the table you're currently in is affected by this command; other tables will still use the setting specified in VoiceOver Utility. VoiceOver remembers the setting for the current table and will use it each time you navigate to that table. When you turn off grouping for a table, you must interact with the table. 
Navigate tables when grouped 
•	     To move to the first cell in the table, press VO-Home. To move to the last cell, press VO-End.
•	     To move from the table to the first item on the webpage, press VO-ShiftHome. To move to the last item on the webpage, press VO-Shift-End.
•	     To move from a cell in the last row to the first row of the next column, press the Down Arrow key.
•	     To exit a table when you're on the first cell, press the Up Arrow or Left Arrow key. When you're on the last cell, press the Down Arrow or Right Arrow key. When you're navigating tables without grouping, you can navigate more quickly to the next column by pressing VO-Command-Y or navigate to the previous column by pressing VO-CommandShift-Y.
Navigate webpages using live regions 
Some webpages contain areas whose content is updated without refreshing the entire page. These areas are called "live regions." For example, a webpage might contain a live region that displays stock prices that are continuously updated, or a banner that displays a new 
�
ad every minute. VoiceOver can detect live regions on a webpage, even when the focus is elsewhere on the webpage, and speak the content in the live region as it changes. You can turn on all live regions, or turn specific live regions on or off. 
Turn all live regions on or off 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Web in the category table, and then select the Enable Live Regions checkbox.VoiceOver will speak the content of every live region it detects. To turn off all live regions, deselect the checkbox.
Turn a live region on or off 
1.	    If live regions are listed in the Web rotor, use the rotor to move to a specific live region.
2.	    Navigate webpages using the Web rotor
3.	    While in the selected live region, press the 0 key to turn the live region on or off. The live region remains on or off until you press the 0 key again.
You can use the Trackpad, NumPad, Keyboard, and Quick Nay Commanders to specify gestures or keys for navigating to the next or previous live region on a webpage, or for turning a live region on or off. You can also specify input keys on a refreshable braille display to work with live regions. 
Assign VoiceOver commands to gestures Assign VoiceOver commands to keys 
Assign VoiceOver commands to braille display keys 
Navigate webpages using landmarks 
Web developers can assign landmark roles to areas of a webpage to identify the purpose or type of content of an area to screen readers, and to make it easier to navigate the webpage. Landmarks are not visible on a webpage. For an example of a webpage that contains landmarks, visit store.apple.com. 
VoiceOver supports all landmarks, including: 
Banner: The area that contains the page name, logo, or other identifying information. Complementary: An area, such as a sidebar, that supports the main content area. 
Content info: The area that contains footnote-type information, such as copyright or privacy statements. 
Main: The area that contains the main content. 
Navigation: The area that contains a navigation bar or other links for navigating the webpage or website. 
Search: The area that contains a search field for searching the webpage or website. 
If landmarks are listed in the Web rotor, you can use the rotor to move to a specific landmark. 
Navigate webpages using the Web rotor 
You can use the Trackpad, NumPad, Keyboard, and Quick Nav Commanders to specify gestures or keys for navigating to the next or previous landmark on a webpage. You can also specify input keys on a refreshable braille display to navigate to landmarks. 
Assign VoiceOver commands to keys Assign VoiceOver commands to gestures 
Assign VoiceOver commands to braille display keys 
Navigate webpages using web spots 
As VoiceOver opens a webpage, it evaluates the visual design, groups items based on the design, and creates an "auto web spot" on the first item in each group on the page. VoiceOver briefly outlines the group with a large rectangle, which transitions into the VoiceOver cursor, positioned on the first auto web spot in the first group. 
You can jump from one auto web spot to another and hear the content in each auto web spot, scanning the webpage for content that interests you. 
�
You can also create your own web spots to mark favorite content on a webpage (say, the top headlines or sports scores) and navigate there more quickly. If you mark one of your web spots as the "sweet spot," it appears first in the list of web spots in the Web rotor, and can have the focus when a web page is displayed. 
Use web spots 
•	     Make sure the VoiceOver cursor is in a web area, such as in Safari or the iTunes Store.
•	     To jump to the next auto web spot, press VO-Command-N. To jump to the previous auto web spot, press VO-Command-Shift-N.
•	     To jump to the next web spot you created, press VO-Command-]. To jump to the previous web spot you created, press VO-Command-F.
Create a web spot 
Press VO-Command-Shift-1. 
You can create an unlimited number of web spots for a webpage. 
Remove a web spot 
Press VO-Command-Shift-{. 
You can delete only web spots you create. 
Set a sweet spot 
Press VO-Command-Shift-}-1. 
To have the VoiceOver cursor focused on the sweet spot when the webpage opens, choose the "Move the VoiceOver cursor to it" checkbox on the Page Loading pane of the Web category in VoiceOver Utility. 
To open the Web rotor to use the lists of auto web spots and web spots you created, press VO-U. You can use the rotor with VoiceOver gestures. 
Use rotor settings with gestures 
If the design of a webpage changes significantly and VoiceOver can't locate a web spot that previously existed on the page, it creates a new one that closely matches the original one. 
Navigate webpages using frames 
Some webpages organize information into separate areas called "frames." Sometimes one frame contains links that update the contents of other frames on the page. You may find it easier to navigate these webpages using frames. 
•	     To move to the next frame, press VO-Command-F.
•	     To move to the previous frame, press VO-Command-Shift-F.
•	     If frames are listed in the Web rotor, you can use the rotor to move to a specific frame.
•	     Navigate webpages using the Web rotor
If frames are listed in the Web rotor, you can listen to the webpage summary to hear how many frames are on the current webpage. 
Hear a summary of a webpage 
Navigate webpages using the Web rotor 
When you browse a webpage, you can display the Web rotor and use it to jump directly to a specific heading, table, link, text field, checkbox, or other item on the webpage, or to navigate a webpage line by line. 
1.	�
  While browsing a webpage, open the Web rotor by pressing VO-U.
2.	   Navigate the lists using the Right Arrow or Left Arrow key until you hear the list you want, such as Headings or Links.
3.	   Navigate the items in the list using the Up Arrow or Down Arrow key until you find the item you want.
•	     If you know the name of an item in a list, type some letters of its name to narrow the list to only items that contain those letters. If you're in the Headings list, you can type the heading level (such as 3) to narrow the list to only headings of that level. To show all items in the list again, press the Delete key.
•	     To hear an item's Internet address, if applicable, press VO-Shift-U. To hear the item's help tag, if available, press VO-Shift-H.
•	     If you don't find the item you want, press the Escape key to exit the rotor without making a selection.
4.   Press Return or the Space bar to select the item and jump to it on the 
webpage.The Web rotor closes. 
You can choose the types of items that are listed in the Web rotor. 
Customize the Web rotor 
If you're using VoiceOver gestures, you can access the web-related rotor settings with a gesture. 
Use rotor settings with gestures 
Chapter 7. Using Mac OS X Applications 
Mac OS X comes with many accessible applications that you can use with VoiceOver, such as Mail, iChat, and iTunes. This chapter provides information about using some of the Mac OS X applications. 
For information about other applications that are compatible with VoiceOver, click the following link to visit the VoiceOver Application Support webpage. 
VoiceOver Application Support 
Address messages in Mail 
When you start typing email addresses in a New Message window in Mail, some recipient names may appear as Smart Addresses. Smart Addresses are names and addresses that are in your address book, your Previous Recipients list, or available mail servers. Smart Addresses show the name within a blue field, which includes a pop-up menu of related commands, such as Reply to Sender or New Message. 
1.	    In Mail, open a New Message window.
2.	    Navigate to the To field, if necessary, and start typing the recipient's email address.You hear the name and email address of the first name that matches what you're typing. If more than one address is available for the recipient, you hear "Mail has new window" and a pop-up menu of addresses becomes available. Use the Down Arrow or Up Arrow key to navigate the list of addresses.
3.	    To enter the selected address in the field, press Return. To delete an address you just entered, press the Delete key once to highlight the address and a second time to delete it. If a recipient has a Smart Address, you hear "menu button," which refers to the pop-up menu in the Smart Address. To open the pop-up menu in a Smart Address, press VO-Shift-M.
4.	    To add another address, repeat steps 2 and 3.You can add as many addresses in the field as you want. If you enter multiple addresses that aren't Smart Addresses,
�
separate them with a comma. 
1.	    To move to the next text field, press VO-Down Arrow.
If it's easier to type email addresses than to use Smart Addresses, turn off Smart Addresses. In Mail, choose Mail > Preferences > Viewing, and then deselect the "Use Smart Addresses" checkbox. 
Read messages in Mail 
Mail lists messages in one or more columns, depending on whether you're using three-column or classic layout. In three-column layout, the preview of the current message appears in the third column, along the right side of the window; in classic layout, the preview appears in a pane under the messages list. 
In three-column layout 
1.   Press VO-Up Arrow or VO-Down Arrow to navigate the messages list until you 
hear the message you want to read.Mail reads the list preview of each message in the message list. If a message is the top message in a conversation, the preview information includes the count of messages in the conversation. 
Z.   Read the message. 
1.	    If the message isn't the top message in a conversation, or if it is but you don't want to expand the conversation in the messages list, press VO-J to jump to the preview pane and start reading the message.If the message was part of a conversation and you want to read the other messages in the conversation, interact with the message and then use VO-Down Arrow or VO-Up Arrow to navigate the other messages in the preview pane.
2.	    If the message is the top message in a conversation and you want to expand the conversation in the messages list, interact with the messages list, interact with the message, and then press VO-Right Arrow until the VoiceOver cursor is on the collapsed disclosure triangle. Press VO-Space Bar to expand it, and then press the Down Arrow to navigate the list of messages in the conversation. The message displayed in the preview pane changes to show the message currently selected in the messages list. To jump to the preview pane to start reading the message, press VO-J. If you're using VoiceOver gestures, keep a finger on the trackpad and press the Control key. When you're done, press VO-J or use the gesture again to jump back to the messages list.
In classic layout 
1.   Press the VO and arrow keys to move across or down each row in the 
messages list until you hear the message you want to read.To hear a description of everything in a row, press VO-R. 
Z.   To start reading the message, jump to the message preview by pressing VO- 
J.If you're using VoiceOver gestures, keep a finger on the trackpad and press the Control key. 
3.   When you're done reading, jump back to the messages list by pressing VO- 
J.If you're using VoiceOver gestures, keep a finger on the trackpad and press the Control key. 
To quickly read through the messages list, press VO-Shift-Down Arrow to interact with it. Then press VO-Right Arrow or VO-Left Arrow until you're in the column you want to hear, such as the Subject column, and then press the Down Arrow or Up Arrow key to move up or down in that column. 
Use data detectors in Mail messages 
Mail can detect specific information or data in messages and make it easier for you to use the data. For example, Mail can recognize phone numbers and add them to your address book, or recognize a date and time and create an iCal event for it. 
1.   In a message you've received, move the VoiceOver cursor over a phone 
number, email address, URL, street address, date, or time.Mail outlines the data as a field with a pop-up menu, and VoiceOver speaks "data detector." 
�
2.  To open a shortcut menu that contains commands for using the data, press 
VO-Shift-M. For example, if the data detector is the URL of a website, you can choose Open URL from the shortcut menu. 
Accept iChat invitations 
If you set iChat preferences to announce when a new invitation arrives and to speak message contents automatically, you'll hear "Chat invitation from [buddy name]" when you're invited to chat, followed by the text of the new message, and finally "iChat has new window." You can ignore the message if you're busy, or switch to iChat and accept the invitation. 
1.	    Press VO-F1 twice to open the Application Chooser menu.
2.	    Press VO-Down Arrow until you hear iChat, and then press VO-Space bar to select it.
3.	    Press VO-Down Arrow until you hear "Chat with [buddy name] new" and then select the command.The VoiceOver cursor moves to the iChat invitation window.
4.	    Type your response in the text field.If you set the initial position of the VoiceOver cursor to be the first item in a window in VoiceOver Utility, you must navigate to and select the Accept button at the bottom of the window before you can type your response.
5.	    Press Return to send your response.
You interact with the iChat window the same way you do with other windows. All the messages in a text chat, including yours, are displayed above the text field in an HTML content area. You can interact with the area to move up and down the messages and read them. 
Hear iChat invitations and messages 
You can set iChat preferences so that iChat announces when a new chat invitation arrives, and speaks the text of new chat messages. You can also set alert preferences for other events and types of chats, such as audio and video chats. 
1.	   In iChat, choose iChat > Preferences, and then click Alerts.
2.	   To hear incoming invitations, click the Event pop-up menu and choose Text Invitation.
3.	   Select the "Speak an announcement" checkbox.
4.	   To hear incoming messages, click the Event pop-up menu again and choose Message Received, and then repeat step 3.
Now when you receive a chat invitation, you'll hear "Chat invitation from [buddy name]," followed by the text of the new message, and finally "iChat has new window." You can ignore the invitation if you're busy, or accept it. 
When cursor tracking is turned on, iChat speaks incoming messages only when you're focused on the message portion of the chat window; if you're typing a message in the text field, incoming messages are not spoken. You can turn off cursor tracking while using iChat, so you can move the VoiceOver cursor to the message portion to hear incoming messages, while the keyboard focus remains in the text field where you're typing. 
Turn off cursor tracking 
You can use hot spots to be alerted of incoming messages. 
Monitor items with hot spots 
Navigate iChat messages 
You can use a VoiceOver command or gesture in iChat to jump between the text field where you type your message and the table of incoming messages. This is useful if you want to review what your buddy said before you send your own message. 
1.   When the VoiceOver cursor is in the text field, press VO-J. If you're 
using VoiceOver gestures, keep a finger on the trackpad and press the Control key. The 
�
VoiceOver cursor jumps to the end of the last message in the HTML content area. 
Z.   To navigate the messages, press VO-Shift-Up Arrow or VO-Shift-Down Arrow. 
3.   To move the VoiceOver cursor back to the text field, press VO-J. If you're 
using VoiceOver gestures, keep a finger on the trackpad and press the Control key. The next time you jump during the same chat, the VoiceOver cursor moves to the last message you read. 
You can turn off cursor tracking while using iChat, so you can move the VoiceOver cursor to the message portion to hear incoming messages, while the keyboard focus remains in the text field where you're typing. 
Turn off cursor tracking 
Use iTunes 
You can use VoiceOver with iTunes to navigate the iTunes Store to buy music, movies, TV shows, apps, and audiobooks, or download free podcasts. You can use all of the general VoiceOver commands to navigate the iTunes window. You interact with toolbars and lists just as you would in any other window. 
To learn more about accessibility solutions for iTunes, open iTunes and search iTunes Help for "accessibility." Or click the following link to visit the iTunes website: Accessibility solutions for iTunes website 
Change tab stops in TextEdit 
You can click tab stop buttons located at the right end of the TextEdit toolbar to add new tab stops. When the VoiceOver cursor is in the ruler, you can add or move tab stops. 
If the ruler isn't available, open TextEdit preferences and make sure the "Show ruler" checkbox is selected. 
Add or change a tab stop 
1.   When the VoiceOver cursor is on a tab stop button or in the ruler, press 
VO-Space bar. 
Z.   In the dialog that appears, press VO-Right Arrow to navigate to the Right 
Tab Stop pop-up menu, and then press VO-Space bar again to open the pop-up menu. 
1.	    Press VO-Down Arrow or VO-Up Arrow to find the type of tab stop you want to add, and then press VO-Space bar to select it.
2.	    Press VO-Right Arrow until you reach the edit text field for the ruler marker value.
3.	    Type the measurement for where you want to place the tab stop. For example, 6.Z5 indicates six and one quarter inches on the ruler.
4.	    Press VO-Right Arrow until you reach the OK button and click it. Drag a tab stop to another location
1.   Interact with the ruler by pressing VO-Shift-Down Arrow, and then locate 
the marker for the tab stop you want to move. 
Z.   Interact with the marker. 
1.	    Press VO-Left Arrow or Right Arrow until the marker is located where you want it.
2.	    Stop interacting with the marker by pressing VO-Shift-Up Arrow.
3.	 
Automate tasks with AppleScript 
You can automate many tasks by writing scripts using the AppleScript programming language included in Mac OS X. After you enable VoiceOver to work with scripts, you can open the VoiceOver AppleScript dictionary in AppleScript Editor to see the terms available to use in scripts. 
Enable using scripts 
1.	�
  When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	   Click General, and then select the "Allow VoiceOver to be controlled with AppleScript" checkbox.
Open the VoiceOver AppleScript dictionary 
1.	   Open AppleScript Editor in Launchpad.
2.	   Choose File > Open Dictionary, and then choose VoiceOver at the bottom of the alphabetical list.
You can use the NumPad, Keyboard, and Trackpad Commanders to assign custom commands that run AppleScript scripts to keys and gestures. You can also assign the commands to braille display keys. 
Chapter 8. Collaborating with Other Users 
This chapter explains how to use features that enhance collaboration between users. You'll learn about the caption panel, the braille panel, the screen curtain, and tiling visuals. You'll also learn how to mute speech and sound effects. 
Use the caption panel 
You can display a panel on the screen that shows what VoiceOver is speaking. The caption  panel is helpful when you're sharing the computer with those around you who are sighted. 
Show or hide the panel 
Do one of the following: 
•	     Press VO-Command-F10.
•	     When VoiceOver is on, open VoiceOver Utility, click the Visuals category, and then click Caption Panel. Select or deselect the "Show caption panel" checkbox.
To show or hide the caption panel, as well as the braille panel and the VoiceOver cursor, press VO-Command-F11. 
Move or resize the panel 
1.	    Press VO-Shift-F10 until you hear the action you want to perform.For example, if you hear "resizing" but you want to move the caption panel, press the keys again to hear "moving."
2.	    Press VO-arrow keys to move or resize the caption panel. To move or resize in smaller increments, press Shift with the arrow keys.
3.	    When you're done, press the Escape key. When the caption and braille panels are displayed at the same time, they can sometimes cover each other. If this happens, move or resize them. Use the braille panel
Turn the screen black using screen curtain 
For added privacy, you can prevent those around you from reading the screen by using the screen curtain, which temporarily turns the screen black. The screen curtain is also useful for sighted users who want to avoid reading the screen while learning to use VoiceOv 
Press VO-Shift-F11. If you're using VoiceOver gestures, triple-tap with three fingers. To turn off the screen curtain, repeat the command or gesture. 
If you turn off VoiceOver while the screen curtain is on, the screen curtain is also turned off. 
�
Use the braille panel 
Even if you don't have a braille display, you can show a panel on the screen that simulates a refreshable braille display, along with a language translation of the braille, so sighted and nonsighted users can read the same text at the same time. 
You can control the panel's appearance and choose whether to show it whenever a braille display is connected to or paired with your computer, and you can move and resize it. When resized, the braille panel can show more cells than may be on the connected braille display; in this case, a thin rectangular line around some cells indicates the braille cells on the physical display. 
Show or hide the panel 
Do one of the following: 
•	     When VoiceOver is on, open VoiceOver Utility, click the Visuals category, click Braille Panel, and then choose an option from the Show Braille Panel pop-up menu.For a description of this and the other options for the braille panel, click the Help button in the lower-right corner of the pane.
•	     Press VO-Command-F9.This command also changes the setting in VoiceOver Utility. If you had set the option to automatically show the braille panel when a braille display is connected or paired with your computer, you must choose that setting again in VoiceOver Utility.
To show or hide the braille panel, as well as the caption panel and the VoiceOver cursor, press VO-Command-F11. 
Move or resize the panel 
1.	    Press VO-Shift-F9 until you hear the action you want to perform.For example, if you hear "resizing" but you want to move the braille panel, press the keys again to hear "moving."
2.	    Press VO-arrow keys to move or resize the braille panel. To move or resize in smaller increments, press Shift with the arrow keys.
3.	    When you're done, press the Escape key.
The braille panel displays what's on the screen even when you mute speech. 
When the braille and caption panels are displayed at the same time, they can sometimes cover each other. If that happens, move or resize them. 
Use the caption panel 
Tile visuals 
You can tile visuals (the VoiceOver cursor, the caption and braille panels, and VoiceOver menus) on the screen. When you tile visuals, the VoiceOver cursor moves to the center of the screen and the rest of the screen is dimmed. 
•	     Press VO-F10. If you're using a portable Mac, you may need to press VO-FnF10.
The caption or braille panel moves to the top or bottom center of the screen, and the item in the VoiceOver cursor moves to the center of the screen. As you continue to navigate, the VoiceOver cursor stays in the center of the screen and you see the item you navigated 
to. 
•	     To untile visuals, press VO-F10 again. •
Mute sound effects 
VoiceOver uses sound effects to let you know what's on the screen and to help you 
�
navigate. You can turn off VoiceOver sound effects without affecting the audio of other applications. 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Sound in the category table, and then select the "Mute sound effects" checkbox.
If you're using VoiceOver gestures, avoid muting sound effects. Hearing the blank space sound effect is very useful in determining where items are located on the desktop. 
Mute speech 
VoiceOver uses speech to let you know what's on the screen and to help you navigate. You can turn off VoiceOver speech without affecting the display in the caption or braille panels, or the audio of other applications. 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Speech in the category table, and then click Voices.
3.	    Select the Mute Speech checkbox.To turn speech on again, deselect the checkbox.
If you're using VoiceOver gestures, you can mute VoiceOver speech and sound effects by double-tapping with three fingers. Repeat the gesture to hear speech and sound effects again. 
Chapter 9. Customizing VoiceOver 
This chapter explains how to customize your VoiceOver environment to best suit your needs. You'll learn how to customize settings for voices, spoken details, braille displays, pronunciations, and more. You'll also learn how to reset, export, and import your preferences, as well as use portable preferences and VoiceOver activities. 
Customize voice settings 
You can change the speaking voice used by VoiceOver, and change the settings, including the voice, rate, pitch, volume, and intonation. You can add compact or premium voices to the list of available voices. Use a keyboard command or VoiceOver Utility to customize voice settings. 
Using a VoiceOver command 
1.	   To hear the first setting, press VO-Command-Right Arrow.If the last adjustment you made was to pitch, that's the first setting you hear; for example, "Pitch 50 percent."
2.	   Continue to press VO-Command-Right Arrow until you hear the setting you want to adjust.
3.	   To increase the setting's value, press VO-Command-Up Arrow. To decrease the value, press VO-Command-Down Arrow.The new settings are applied only to the default voice.
Using VoiceOver Utility 
1.	   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	   Click Speech in the category table, and then click Voices.
3.	   In a Voice pop-up menu, choose a voice.
o   To choose one voice to speak everything, choose a voice from the Voice 
�
pop-up menu for the Default category. 
•	     To choose different voices for specific categories, such as attributes, click the disclosure triangle to the right of the Default voice options, and choose a voice from the Voice pop-up menu for each category.
•	     To add compact or premium voices to the pop-up menus, choose Customize, and then select the checkbox for each voice you want to add. When you select some voices, a yellow triangle appears, indicating those voices will be downloaded. Once downloaded, they appear in the menu.
4.   Set the rate, pitch, volume, and intonation for each voice in the fields 
to the right of the Voice pop-up menu.You can type a number in the fields or use the steppers next to each field to adjust the values. 
If you install voices that are compatible with Mac OS X in your —/Library/Speech/Voices folder, they appear in the list of available voices. To make the voices available to other users who have access to your computer, install the voices in /Library/Speech/Voices. 
If you're using portable preferences on a guest computer when you change settings, the settings are saved to the portable preferences drive and not to the guest computer. Use portable preferences 
Customize the verbosity level for speech or braille 
By default, VoiceOver provides a high level of detail to help new Mac and VoiceOver users. You can choose a different default setting, and choose a verbosity level for specific controls, such as checkboxes or scroll areas, that you want to hear or receive on a refreshable braille display. You can also change the order in which VoiceOver provides the details. 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click the Verbosity category, and then click Speech or, if you're using a braille refreshable display, click Braille.
3.	    Change verbosity levels.
•	     To change the default verbosity level, choose High, Medium, or Low from the pop-up menu.
•	     To change the verbosity level for specific items, click the disclosure triangle to the right of the default verbosity level. Then navigate the list of controls until you find the one you want to customize. Use the arrow keys to navigate to the control's Verbosity pop-up menu, and then choose Default, Low, Medium, or High. To change the order in which VoiceOver provides the information, choose Customize from the Verbosity pop-up menu, and then follow the instructions in the pop up. Or you can navigate to Description and type the elements (Status, Type, or Name) you want to hear in the order you want to hear them.
Customize the layout of braille displays 
If you have a refreshable braille display connected to or paired with your computer, you can customize its layout. For example, you can choose to use contracted braille or specify which status cells you want to use. 
1.	   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	   Click Braille in the category table, and then click Layout.For a description of the options, click the Help button in the lower-right corner.
Customize the Web rotor 
You can change the Web rotor to list only the types of items, such as links or tables, that you use most often when browsing webpages. 
1.   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8. 
1.	�
   Click Web in the category table, and then click Web Rotor.
2.	    Select the checkbox for each item you want to include in the Web rotor. To change the order of items in the rotor, select an item and then press Cmd-Up Arrow or CmdDown Arrow to move the item up or down in the list.For a description of the options in the pane, click the Help button in the lower-right corner.
The types of items you include in the rotor determine the statistics VoiceOver speaks in the webpage summary. 
Hear a summary of a webpage 
Customize how text and symbols are pronounced 
You can specify how you want VoiceOver to pronounce certain text or symbols by providing substitutions for them. For example, you can substitute "8 oh 2 dot eleven b" for "8 zero 2 point one one b." Or substitute "Wink Smiley" for "semicolon dash right parenthesis." 
Add a pronunciation 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Speech in the category table, click Pronunciation, and then click Add (+) in the lower-left corner of the pane.
3.	    In the new row, type the text whose pronunciation you want to customize, press Tab to move to the Substitution column, and then type how you want VoiceOver to pronounce the text.
4.	    If you want to specify an application where VoiceOver should use the pronunciation, choose the application from the Application pop-up menu.The menu lists open applications and Find Apps, so you can select an application that isn't open. To use the pronunciation in any application, leave All Apps selected.
5.	    To have capitalization ignored, select the Ignore Case checkbox.
Edit a pronunciation 
Do one of the following: 
•	     Navigate to the field you want to edit, press Space bar, and then type new text or a new pronunciation.
•	     Choose a different application (or All Apps) from the Applications pop-up menu.
•	     Change the Ignore Case setting.
Remove a pronunciation 
Select the pronunciation and click Remove (-) in the lower-left corner of the pane. 
You can quickly customize pronunciations by using the Commanders to assign the Add Pronunciation command to a key or gesture. The command displays a dialog where you can add a new pronunciation, which is then added to the list in the Pronunciation pane in VoiceOver Utility. 
Create custom labels 
You can create or rename the label for user interface elements (such as images, buttons, tables, and more) and for links. You can export your custom labels to a file to share with other users. 
1.   Position the VoiceOver cursor on the element or link for which you want to 
create a label. 
1.	�
   Press VO-/.
2.	    In the dialog that's displayed, type the label you want to use and press Return.
When you create a custom label, VoiceOver associates pertinent information about the element or link and its location with your label. If the element or link changes in a significant way, such as moving to a new location, VoiceOver may not recognize it as the same element or link. If this happens, re-create the custom label. 
You can't create labels for scroll areas, toolbars, or groups. 
When you import a preference file that contains custom labels, VoiceOver merges those labels with your current set of custom labels. 
Assign VoiceOver commands to keys 
If your computer has a numeric keypad, you can use the NumPad Commander to assign VoiceOver commands to numpad keys, so you can enter the commands using only the numeric keypad. You can use the Keyboard Commander to assign VoiceOver commands to keyboard keys. 
The NumPad Commander already has some basic navigation and interaction commands assigned to some keys. The Keyboard Commander has scripts and shortcuts for opening applications assigned to some keys. To use the default key assignments, just enable the Commanders. You can change the defaults or add your own. 
1.	   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	   Click Commanders in the category table, click NumPad or Keyboard, and then  in the NumPad or Keyboard pane, select the checkbox to enable the Commander.
3.	   Choose a modifier key.Using a modifier key with numpad keys is optional;  you must use a modifier key with keyboard keys.
In the Keyboard Commander pane, choose the Left Option key, the Right Option key, or both Option keys as the modifier key. 
1.	   Interact with the Commander table and navigate down the key column until  you hear the numpad or keyboard key you want to assign a command to.
2.	   Move to the Command column, open the pop-up menu of commands, and then use  the arrow keys to navigate the available commands.
3.	 
4.	   When you hear the command you want to assign to the current numpad or  keyboard key, press Return to select it.
When the NumPad Commander is on, the NumPad Commander commands are included in the VoiceOver Commands menu. To display the Commands menu, press VO-H-H. 
Find commands using the Commands menu 
You can use the Custom Commands menu to assign scripts and Automator workflows to keys. For example, you could run a script (such as a Perl, Ruby, Python, or AppleScript script) when you press a specific key on the keyboard. 
Reset preferences 
If you have changed your VoiceOver preferences, you can reset all or specific preferences to their default values. 
IMPORTANT:It's recommended you export your preferences before you reset them, so you have a backup copy of your preferences in case you want to use them again. 
Export and import preferences 
1.	   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	   Open the File menu, and then choose the reset command for the preferences  you want to reset.You can choose to reset basic, custom (such as hot spots or Keyboard Commander key assignments), or all preferences.
If you have portable preferences on a removable storage drive and you reset basic or all 
�
VoiceOver preferences on your computer, VoiceOver no longer recognizes the drive and doesn't synchronize VoiceOver preferences on your computer and the drive. To synchronize VoiceOver preferences again, you must set up the portable preferences drive again. 
Use portable preferences 
Export and import preferences 
You can export all or specific VoiceOver preferences to a file that you can use as a backup copy. 
Note that if you want to easily use your settings on other Mac computers and keep an up-to-date copy of your current settings always available, use portable preferences. 
Use portable preferences 
Export preferences 
1.	    In VoiceOver Utility, choose File > Export Preferences or press ShiftCommand-E.
2.	    Type a name for the file, and then choose the folder where you want to save the file.To choose from more folders, click the disclosure arrow after the filename.
3.	    From the Export pop-up menu, choose the type of preferences you want to export.
4.	    Click Save.The default filename indicates the type of preferences exported and has the filename extension "voprefs." The file will not reflect changes you make to preferences after you export it.
Import preferences 
1.	    In VoiceOver Utility, choose File > Import Preferences or press ShiftCommand-I.
2.	    Browse for and select the preferences file you want to import.
3.	    Click Open.VoiceOver replaces the current preferences of that type with those in the file. If you're importing web spots or labels, VoiceOver merges them with your existing web spots or labels.
You can import preference files from VoiceOver in Mac OS X 10.5 or later. If a preference existed in Mac OS X 10.5 or later but no longer exists in Mac OS X 10.7, the preference is not imported. 
Use portable preferences 
You can make your VoiceOver preferences "portable" by storing them on a removable storage device. You can use portable preferences to easily use your settings on other Mac computers and to keep an up-to-date copy of your current settings always available. 
Set up the portable preferences drive 
Do this set of steps once for each removable drive you want to use. 
1.	    Insert the removable drive in your computer.
2.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8, and then choose File > Set Up Portable Preferences or click Set Up in the General category table.
3.	    Select a drive from the list of removable drives and click OK.VoiceOver creates a VoiceOver folder on the drive.
Use the portable preferences drive 
�
When you connect your portable preferences drive to a computer, VoiceOver detects the drive and asks if you want to use it. How VoiceOver uses the portable preferences drive depends on the computer you're using: 
If you're using the computer where you set up the drive: Any changes you make to VoiceOver preferences until you eject the drive are automatically saved to the drive. For example, if you increase the speech rate, your change is instantly saved to the portable preferences drive. 
If you're using another computer (as a guest): VoiceOver uses the preferences stored on the drive. Any changes you make to VoiceOver preferences until you eject the drive are automatically saved to the drive and not to the guest computer. The next time you use the drive on the computer where it was set up, VoiceOver synchronizes preferences on the computer and the drive, based on the most recent change to a preference. 
Stop using the portable preferences drive 
When you're done, eject the portable preferences drive using Finder, or click Stop in the General category table in VoiceOver Utility (in this case, the drive is not ejected). 
If you choose not to use the portable preferences drive when VoiceOver asks you, but later want to use it, open VoiceOver Utility and click Start in the General category table. If you choose to always use the portable preferences drive, but later want to use it only sometimes, delete the preferences file from the drive, and then set up the portable preferences drive again. 
You can export all or specific VoiceOver settings as a file to save or share. This file is not updated and will not reflect changes you make to preferences after exporting. You can import preference files from VoiceOver in Mac OS X 10.5 and later. 
Export and import preferences 
If you have portable preferences on a removable storage drive and you reset basic or all VoiceOver preferences on your computer, VoiceOver no longer recognizes the portable preferences on that drive and doesn't synchronize VoiceOver preferences on your computer and the drive. To synchronize VoiceOver preferences again, you must set up the portable preferences drive again. 
Use VoiceOver activities 
You can use VoiceOver activities to create groups of preferences for specific uses. For example, you can create an activity to use a certain voice and faster speaking rate when you're shopping online catalogs, and create a second activity to use a different voice and slower speaking rate when you're reading online newspapers. You can switch activities manually or have VoiceOver switch automatically based on the applications you use. 
Set up activities 
1.	   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	   Click Activities in the category table, and then click Add (+) to create an activity.
3.	   Type a name for the activity, such as "Online Shopping."To rename an activity, select the activity in the table, press Enter, and then type a new name.
4.	   For each preference you want to customize for this activity, select the checkbox and then click Set. To show all the preferences you can include, click the disclosure triangle to the far right of Hot Spots.
5.	   To have VoiceOver automatically use the activity for certain applications, click the Select Apps button, and then choose one or more applications from the list, or browse for applications. An application can be associated with only one activity. If you select an application that's associated with another activity, you're asked if you want to
�
change it. 
To disassociate an application, select it again; the checkmark next to its name is removed. 
Use an activity 
•	     If you switch to or open an application with which you associated an activity, VoiceOver identifies the activity if you set verbosity to Medium or High.
•	     To manually choose an activity to use, press VO-X to display the Activity Chooser, use the Down Arrow and Up Arrow keys to navigate the list until you find the one you want to use, and then press Return.
•	     To use the previous activity, press VO-X-X.
•	     To exit the Activity Chooser without making a selection, press the Escape key.
Chapter 10. Using Braille Displays 
This chapter provides information about using refreshable braille displays, both plug in and Bluetooth, with VoiceOver. This chapter also includes a list of the many types of braille displays VoiceOver supports. 
About refreshable braille displays 
If you connect or pair a supported braille display to your computer, VoiceOver automatically detects it and sends it information about what is displayed on the screen. You can connect multiple braille displays to your computer and each display will mirror the same content at the same time, which can be useful in a classroom setting. 
By default, VoiceOver displays uncontracted braille, which you can also display using eight-dot braille. You can also use contracted braille; if you do, VoiceOver dynamically changes the display under the cursor from contracted to uncontracted braille, so that you can read and edit more easily, and then changes back to contracted braille when you move the cursor. 
A braille display typically contains more than just the contents of the VoiceOver cursor. It describes the contents of the entire line on which the VoiceOver cursor is focused, including items to the left and right of the VoiceOver cursor. For example, when the VoiceOver cursor is focused on an item in a window, the braille device displays items like icons, checkboxes, and pop-up menus, as well as text that is to the left and right of the item in the VoiceOver cursor. This collection of items—the VoiceOver cursor and the items to its left and right on the same horizontal line—make up a "line" of braille. 
When you interact with an item in the VoiceOver cursor to get more detail about it, the braille description changes to provide more detail as well. For example, if you move the VoiceOver cursor onto a toolbar, VoiceOver describes only the toolbar on the braille display, because toolbars stretch the entire width of a window. When you interact with the toolbar, the braille display describes each item in the toolbar from left to right. VoiceOver raises dots 7 and 8 to indicate the position of the VoiceOver cursor, to help you locate it within the line of braille. (You can turn off this feature in VoiceOver Utility.) Similarly, when you're editing or selecting text, the text selection is represented by dots 7 and 8. VoiceOver also indicates the position of the text selection cursor, called the "I-beam," by flashing dot 8 of the braille cell preceding the text selection cursor and dot 7 of the braille cell trailing the text selection cursor. VoiceOver provides additional information about what's on the screen using three status cells. Each status cell provides a designated type of information. You can set the number of status cells that are used and their location on the braille display. For example, you can choose to use the cell that shows text status and set its location to be on the left of your display. 
VoiceOver detects the type of braille display you're using and sets default preferences appropriate for that display. Use VoiceOver Utility to assign VoiceOver commands to keys on your braille display. You can use the braille display while listening to VoiceOver speak, or you can mute the speech. If your braille display has a Perkins-style keyboard, 
�
you can type on it. 
Pair a Bluetooth braille display 
Before you can use a supported Bluetooth braille display with VoiceOver, you must pair your braille display with your computer. You can pair only one Bluetooth braille display at a time. You pair the display only once; it remains paired until you remove it from the list of displays. After your braille display is paired, VoiceOver detects it whenever it's turned on and within range; if it's your primary braille display, you can then use it. 
1.   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8. 
Z.   Click the Braille category, click Displays, and then click Add (+). 
1.	    Select your Bluetooth braille display in the list.VoiceOver lists only the Bluetooth braille displays that are within range of your computer and that appear to match a VoiceOver braille display driver.
2.	    Click Select.You may be asked to provide a pairing passcode (such as 0000 or 1234, two common default codes). Check the documentation that came with your braille display for the passcode.
If the Bluetooth braille display you selected in the list doesn't work with VoiceOver, it's likely that its driver doesn't match a VoiceOver driver. Try pairing a different Bluetooth braille display. 
If your Bluetooth braille display isn't listed, make sure you have set the display to be discoverable. For more information, check the documentation that came with your braille display. 
About panning on a braille display 
Sometimes a line of braille is too wide to fit on the braille display. You can move through, or "pan," the line by pressing the left and right buttons on the display. Each left or right pan moves according to the number of cells (including status cells) your display contains. 
When you move the VoiceOver cursor using the VoiceOver keys, the braille display automatically pans when necessary to follow it, even wrapping to the previous or next line. 
Use router keys on a braille display 
Many braille displays have router keys above the braille cells that you can use to move the cursor. Generally, you press the router key above a particular item in the line of braille to move the VoiceOver cursor or selection to that item. 
Pressing a router key over a control moves the VoiceOver cursor to that control if the VoiceOver cursor is not already there. If the VoiceOver cursor is already on that control, pressing the router key performs the control's default action. For example, to click a button, you could press the router key to move the VoiceOver cursor to the button and then press the router key again to click the button. You would not have to touch the computer's keyboard at all. Similarly, when you're reading or navigating text and you press a router key, the VoiceOver cursor moves to that location in text. 
You can also press the router key above a status cell to display an expanded braille description of each dot in the cell. To exit the description, press any other router key. 
Show status information on a braille display 
The cells of a braille display show the content of the line on the screen where the VoiceOver cursor is focused. If your braille display has dedicated status cells, VoiceOver can use them to show additional information about the line, such as the text attributes. 
�
If your braille display doesn't have status cells, VoiceOver uses the first one to three cells on the left to show status (or you can have VoiceOver use the cells on the right). VoiceOver reserves another cell, which it leaves blank, as a separator between the status cells and the other cells. 
1.	    When VoiceOver is on, open VoiceOver Utility by pressing VO-F8.
2.	    Click Braille in the category table, and then click Layout.
3.	    Select one or more of the checkboxes next to Status Cells.If you don't select any of the following checkboxes, status is not shown, and all of the reading cells are used to show the content of the current line.
4.	    Show general display status: Show information about the direction in which to pan the current line, and about announcements. For example, dots 1 and 2 indicate unread and read announcements, and dots 7 and 8 indicate you can pan the display left or right.
Show text style: Show common text styles, such as bold or italic font. For example, dots 1 and 2 indicate bold and italic text respectively, and dot 4 indicates the selected text is misspelled. 
Show extended text style: Show less common text styles, such as strikethrough or superscript. For example, dots 1 and 2 indicate text is superscript or subscript respectively, and dot 5 indicates the selected text has a double underline. 
Press the router key above a status cell to display an expanded braille description of each dot in the cell. To exit the description, press any other router key. 
Review announcements on a braille display 
VoiceOver sends announcements to the braille display about events that aren't represented visually on the screen. For example, if an application in the background needs attention or if a new window appears onscreen, VoiceOver sends an announcement to the braille display. VoiceOver stores up to 30 announcements in the history, with the most recent one listed first. 
If you chose to show general display status on your braille display, you can review announcements. 
Show status information on a braille display 
•	     On the status cell that shows general display status, dot 1 indicates whether there are new unread announcements. Dot 2 indicates whether the current announcement has already been read.
•	     If you assigned the Announcement History command to a braille display key, press that key to show the most recent announcement in the reading cells.
•	     To cycle through the announcement history, press the Up Arrow key to move backward to the oldest announcement, and press the Down Arrow key to move forward to the most recent announcement.
When you're done reviewing announcements, press any router key above the announcement to redisplay the current line. 
Assign VoiceOver commands to braille display keys 
VoiceOver detects whether your braille display provides input keys and assigns common VoiceOver commands to the keys. In this way, you can work more efficiently by using the computer keyboard less. For example, VoiceOver might assign the Down command to the D3 key; when you press that key on your braille display, the VoiceOver cursor moves down one line on the screen. You can change the default assignments and add your own. 
1.   With your braille display connected to or paired with your computer and  with VoiceOver on, open VoiceOver Utility by pressing VO-F8. 
Z.   Click Braille in the category table, click Displays, select the braille 
display you want to assign commands for, and then click Assign Commands. 
�
3.  Assign a VoiceOver command to braille display keys. 
o   To change the command assigned to keys listed in the table, navigate to 
the keys, and then choose a command from the pop-up menu. 
o   To add new braille keys to the table so you can assign a command to them, 
click Add (+) to add a row, press Command-B, and then within five seconds press the braille keys you want to add. A sound effect counts down the seconds. Then choose the command you want to assign to the keys from the pop-up menu. 
To remove braille keys you added, click Remove (-). 
Mirror a braille display 
You can connect multiple USB braille displays to your computer and have all of them display the same braille output at the same time. The braille displays can be of different types and models; they don't need to be the same. 
1.	    Connect or pair with your computer the braille display you want to use to control all other braille displays that are connected to your computer. This display is called the "primary braille display."
2.	    In the Displays pane of the Braille category in VoiceOver Utility, select the braille display and then select the "Primary braille display" checkbox in the display information section.To prevent input from other braille displays that are connected to your computer, choose "Primary braille display" from the "Allow input from" pop-up menu.
3.	    Connect additional braille displays to your computer. These displays will mirror the output from the primary braille display.
Supported braille displays 
Mac OS X supports a wide range of USB and Bluetooth braille displays. 
NOTE:Bluetooth only, or USB and Bluetooth, displays are indicated in the table. If neither label appears, a display is USB only. 
MANUFACTURER 
MODEL 
Alva 
BC640 (USB and Bluetooth) 
BC680 (USB and Bluetooth) 544 Satellite 
544 Satellite Traveller 570 Satellite Pro 
584 Satellite Pro 
American Printing House for the Blind (APH) Refreshabraille 18 (USB and Bluetooth) 
Baum 
PocketVario 24 (USB and Bluetooth) 
SuperVario 32 (USB and Bluetooth)  SuperVario 40 (USB and Bluetooth)  SuperVario 64 (USB and Bluetooth) 
�
SuperVario 80 (USB and Bluetooth) 
VarioConnect 12, also called Conny 12 (Bluetooth) 
Note: VoiceOver identifies this display as HumanWare BrailleConnect 12. 
VarioConnect 24 (USB and Bluetooth) VarioConnect 32 (USB and Bluetooth) VarioConnect 40 (USB and Bluetooth) VarioPro 64 
VarioPro 80 
Deininger 
Pegasus 42/4 CR 
Pegasus 82/8 CR 
Eurobraille 
Esys 12 (USB and Bluetooth) 
Esys 24 (USB and Bluetooth) Esys 40 (USB and Bluetooth) 
Esys Light 40 (USB and Bluetooth) Esys 64 (USB and Bluetooth) 
Esys 80 (USB and Bluetooth) Freedom Scientific 
Focus 40 
Focus 40 Blue (USB and Bluetooth) Focus 44 
Focus 70 
Focus 80 
Focus 84 
PAC Mate 20 
PAC Mate 40 
PAC Mate BX420 (display only) PAC Mate BX440 (display only) PAC Mate QX420 (display only) PAC Mate QX440 (display only) 
�
HandyTech 
Braille Star 40 (USB and Bluetooth) 
Braille Star 80 
Braille Wave (USB and Bluetooth) Braillino (Bluetooth) 
Easy Braille (USB and Bluetooth) Modular Evolution 64 
Modular Evolution 88 Harpo 
BraillePen (Bluetooth) 
BraillePen 12 (Bluetooth) 
HIMS/GW Micro 
BrailleSense (USB and Bluetooth, requiring a Bluetooth module) 
BrailleSense Plus (USB and Bluetooth, not requiring a Bluetooth module) SyncBraille 20 
SyncBraille 32 
Humanware 
BrailleConnect 12 (Bluetooth) 
BrailleConnect 24 (USB and Bluetooth) BrailleConnect 32 (USB and Bluetooth) BrailleConnect 40 (USB and Bluetooth) BrailleNote Apex BT (USB and Bluetooth) 
BrailleNote Apex QT (USB and Bluetooth) 
Note: VoiceOver supports only the navigation keys on this display. 
BrailleNote mPower BT 18 (Bluetooth)  BrailleNote mPower BT 32 (Bluetooth) 
BrailleNote PK (Bluetooth) 
Note: VoiceOver identifies this display as Humanware BrailleNote mPower BT 18. 
Brailliant 24 (USB and Bluetooth) Brailliant 32 (USB and Bluetooth) Brailliant 40 (USB and Bluetooth) Brailliant 64 (USB and Bluetooth) 
�
Brailliant 80 (USB and Bluetooth) MDV 
Lilli 
MB408L (Bluetooth) Ninepoint Systems Cebra 
Ninepoint 
Nippon Telesoft  Seika Version 3 
Seika Version 4 (USB and Bluetooth) 
Seika 80 
Optelec 
EasyLink (Bluetooth) 
EasyLink 1Z (Bluetooth) 
Voyager 44 
Papenmeier 
Braillex EL 40s 
Braillex EL 80s 
Braillex Trio (USB and Bluetooth) Chapter 11. Using VoiceOver Gestures 
This chapter explains how you can control your computer using VoiceOver gestures on a Multi-Touch trackpad. 
About VoiceOver gestures 
If you have a Multi-Touch trackpad and VoiceOver is turned on, you can use gestures to navigate and interact with items on the screen, and enter VoiceOver commands. 
To use VoiceOver gestures with a trackpad, you enable the Trackpad Commander by holding down the Control and Option keys (called the "VO keys") while rotating two fingers clockwise on the trackpad, or by selecting the option in VoiceOver Utility. Once enabled, you can use a set of standard VoiceOver gestures, and you can customize other gestures by assigning VoiceOver commands to them. If you're using more than one Multi-Touch trackpad, you must enable the Trackpad Commander on each trackpad. 
VoiceOver gestures involve using one or more fingers to drag, tap, flick, or rotate on the trackpad. You can use different techniques for a gesture. For example, you can tap using two fingers from one hand, or one finger from each hand. Try different techniques to discover which one works best for you. You can use keyboard help to practice standard and customized gestures and learn what they do. 
When you touch the trackpad, it's as if you're touching a portion of the screen. The trackpad represents the window or area on the screen where the VoiceOver cursor is located. When you drag a finger on the trackpad, you move the VoiceOver cursor only in 
�
that window or area. VoiceOver speaks the items in the VoiceOver cursor as you move the cursor, and plays a sound effect whenever it encounters a blank space on the screen. This information helps you gain a sense of the actual location of items on the screen as you navigate. For example, if the cursor is in the Mail toolbar, the trackpad represents the Mail toolbar. When you drag your finger on the trackpad, you move the VoiceOver cursor in the Mail toolbar. Because the trackpad represents only a specific area and not the entire screen, you can't stray to other areas or applications by accident. 
To enhance collaboration with sighted users, VoiceOver makes the area of the screen you're working in more visible by dimming the rest of the screen. You can adjust the transparency of this effect using the Touch pane in VoiceOver utility. Other collaboration features, such as the caption or braille panels, can also be used at the same time as VoiceOver gestures. 
To disable the Trackpad Commander and stop using VoiceOver gestures with a trackpad, hold down the Control and Option keys while rotating two fingers counterclockwise on the trackpad, or select the option in VoiceOver Utility. 
Use VoiceOver gestures 
If you're using a Multi-Touch trackpad, you can use gestures to navigate and interact with items on the screen. To start using VoiceOver gestures, you must enable the Trackpad Commander. 
VoiceOver has a standard set of gestures that you can't customize, and other gestures that you can customize by assigning VoiceOver commands. 
NOTE:When you're using VoiceOver gestures, you can't use the mouse button on the trackpad, unless the mouse button is used with a modifier key, as in Control-click. 
Enable the Trackpad Commander 
Hold down the Control and Option keys (the "VO keys") and rotate two fingers clockwise on the trackpad. 
Use VoiceOver gestures 
•	     VoiceOver includes standard gestures for navigating and interacting with items on the screen. You can't change these gestures.
•	     VoiceOver standard gestures
•	     You can customize other gestures by assigning VoiceOver commands to them.
•	     Assign VoiceOver commands to gestures
•	     You can use a rotor to navigate text areas, windows, dialogs, and webpages, and adjust controls such as sliders, steppers, and splitters.
•	     Use rotor settings with gestures
•	     Here are some tips to keep in mind as you use VoiceOver gestures: If you don't know where you are on the screen, tap three times. VoiceOver tells you what is in the VoiceOver cursor.
o   When you're dragging a finger and you hear something you want to select, 
keep your finger on the trackpad and use a second finger to tap. This gesture is called a "split-tap." 
0 
Disable the Trackpad Commander 
Hold down the Control and Option keys (the "VO keys") and rotate two fingers counterclockwise anywhere on the trackpad. 
�
You can use both VoiceOver gestures and keyboard shortcuts to enter VoiceOver commands. Assign VoiceOver commands to gestures 
If you use VoiceOver gestures, you can customize some gestures by assigning specific VoiceOver commands to them. 
NOTE:VoiceOver includes a set of standard VoiceOver gestures, which you can't change. VoiceOver standard gestures 
1.   When VoiceOver is on, open VoiceOver Utility by pressing VO-F8. 
Z.   Click the Commanders category, click Trackpad, and make sure the Enable 
Trackpad Commander checkbox is selected. 
1.	    Click Assign Commands.
2.	    From the pop-up menu, choose a modifier key (Command, Option, Control, or Shift) to use with your customized gestures. By default, No Modifier is selected in the pop-up menu and the standard VoiceOver gestures, which don't use a modifier key, are listed.
3.	    Interact with the Trackpad Gesture Commands table and navigate down the Trackpad Gesture column until you hear the gesture you want to assign a command to.
4.	    Interact with content areas
5.	    Move to the Command column, open the pop-up menu of commands, and then use the arrow keys to navigate the available commands.
6.	 
7.	    When you hear the command you want to assign to the current gesture, press Return to select it.
8.	   When you're finished assigning commands, click Done.
You can use the Custom Commands menu to assign scripts and Automator workflows to gestures. For example, you could run a script (such as a Perl, Ruby, Python, or AppleScript script) when you use the gesture Command Two-Finger Double Tap. 
Use rotor settings with gestures 
If you're using VoiceOver gestures, the rotor is like a virtual dial you turn to change how you navigate, based on the current context. For example, when you're browsing a webpage, use settings such as tables, web spots, or links. In other contexts, use settings such as navigation, words, or characters. 
1.   Rotate two fingers until you hear the setting you want to use.As you 
"turn" the rotor, VoiceOver speaks each setting and plays a clicking sound. If you miss a setting, keep turning the rotor until you hear the setting again. 
Z.   Flick up or down to navigate to the previous or next instance of an item, 
based on the current setting.For example, if the current setting is Words, then flicking down moves the VoiceOver cursor to the next word. Keep flicking down to move forward word by word. If you repeatedly flick up, the VoiceOver cursor moves backward word by word. Here are some of the settings you can use: 
3.   Web settings: The settings depend on how you've customized the Web rotor 
in VoiceOver Utiility. By default, the settings include Links, Headings, Form Controls, Web Spots, Tables, and Landmarks. 
Other settings: Characters, Words, Navigation. 
The Characters and Words settings are most useful when interacting with a text area, to read the text by character or by word. 
The Navigation setting navigates text line by line. When you're interacting with a text area, VoiceOver begins speaking the first line at the point where the cursor was located when you first flicked up or down; it speaks each subsequent line in its entirety. 
When you use the Navigation setting in a window or dialog, VoiceOver might not speak all of the items on a line, depending on how the items are arranged. You may need to flick 
�
left or right and then flick up or down again to hear other items. 
The current web navigation mode affects how you navigate webpages using the rotor. In DOM mode, flicking up or down moves to the previous or next instance of the item that matches the current rotor setting. For example, if the rotor is set to headings, flicking up or down moves to the previous or next heading. You can assign the "Toggle Web Navigation DOM or Group" command to a gesture using the Trackpad Commander, to easily switch modes to suit your needs. 
Appendix A. Commands and Gestures 
This appendix lists VoiceOver commands and gestures, organized into categories. 
General commands 
Use these commands to turn VoiceOver on and off, get help, change basic settings, and enable and disable Commanders. 
NOTE:If your keyboard has an Fn key, press the Fn key when you press a function key. ACTION 
COMMAND 
Turn VoiceOver on or off 
Command-F5 
Lock and unlock the VO (Control and Option) keys 
VO-; 
Open VoiceOver Utility 
VO-F8 
Start keyboard help 
VO-K 
Open the VoiceOver Help menu 
VO-H 
Open the VoiceOver Quick Start 
VO-Command-F8 
Open VoiceOver online help 
VO-? 
Read the help tag for the current item 
VO-Shift-H 
Read the VoiceOver hint for the current item 
VO-Shift-N 
Open the Commands menu 
VO-H-H 
Open the Find Commands menu 
VO-Shift-F 
Close a menu or rotor, stop an action, or exit a mode 
Escape 
Tell VoiceOver to ignore the next key or key combination you press 
VO-Tab 
Open the Verbosity rotor 
VO-V 
Then press the Left Arrow or Right Arrow key to choose the setting. Use the Up Arrow and Down Arrow keys to change the level for the setting. 
Increase magnification of the item in the VoiceOver cursor 
VO-1 
Decrease magnification of the item in the VoiceOver cursor 
VO-{ 
Temporarily hide or show the VoiceOver cursor and the caption or braille panels 
�
VO-Command-F11 
Hide or show the caption panel only 
VO-Command-F10 
Resize or move the caption panel 
VO-Shift-F10 
Press again to cycle through these actions. Then use the arrow keys to resize the panel or move it. Press the Shift key with the arrow keys to move in smaller increments. 
Hide or show the braille panel only 
VO-Command-F9 
Resize or move the braille panel 
VO-Shift-F9 
Press again to cycle through these actions. Then use the arrow keys to resize the panel or move it. Press the Shift key with the arrow keys to move in smaller increments. 
Tile visuals (dim the screen, highlight the caption or braille panel, and show the item in the VoiceOver cursor in the center of the screen). 
VO-F10 
Press again to return to the normal view. 
Enable or disable the NumPad Commander 
VO-Clear 
Enable or disable the Keyboard Commander 
VO-Shift-K 
Enable or disable the Trackpad Commander 
Press the VO (Control and Option) keys and rotate two fingers clockwise (enable) or counterclockwise (disable) 
Turn the screen curtain on or off 
VO-Shift-F11 
Cycle through speech settings in the rotor (rate, pitch, volume, intonation, voice) VO-Command-Right Arrow or Left Arrow 
Increase or decrease the current speech setting (rate, pitch, volume, intonation, voice) VO-Command-Up Arrow or Down Arrow 
Interaction commands 
Use these commands to interact with items on the screen. 
NOTE:If your keyboard has an Fn key, press the Fn key when you press a function key. ACTION 
COMMAND 
Start interacting with an item 
VO-Shift-Down Arrow 
Stop interacting with an item 
VO-Shift-Up Arrow 
Perform the default action for the item in the VoiceOver cursor 
VO-Space bar 
Click the mouse 
VO-Shift-Space bar 
Start multiple selection in a list or table, and select each item 
VO-Command-Space bar 
To stop multiple selection, cut or copy the selected items, press Escape, or stop interacting with the list or table in which the items are located. 
Perform a sticky mouse down or mouse up (for use when dragging an item from one location to drop in another location) 
VO-Command-Shift-Space bar 
Select a menu or list item 
VO-Return 
Open or close a disclosure triangle 
VO-\ 
�
Read a row in a table 
VO-R 
Read the column header in a table 
VO-C 
Read a column in a table 
VO-C-C 
Read row and column numbers in a table 
VO-Shift-T 
Read the number of columns and rows (the dimensions) in a table 
VO-Shift-T-T 
Sort a column in a table 
VO-I 
Interact with scroll bars 
VO-Shift-S 
Then use the arrow keys to scroll up or down or side to side. To scroll vertically one page at a time, use Page Up and Page Down. To scroll horizontally one page at a time, use Shift-Page Up and Shift-Page Down. 
Resize a window 
VO-- 
Select an edge or corner to resize from the Window Resize Options menu, and then resize it 
To resize an edge, use the VO and arrow keys (for example, press VO-Right Arrow to extend the right edge of a window). To resize a corner, use VO and two arrow keys (for example, press VO-Right Arrow-Up Arrow to extend the top right corner of a window). To resize in smaller increments, also press Shift. 
Move a window 
VO-' 
Then use the VO and arrow keys (for example, press VO-Left Arrow to move a window left). To move a window diagonally, use VO and two arrow keys (for example, press VO-Left Arrow-Up Arrow to move a window diagonally left and up). To move in smaller increments, also press Shift. 
Resize an object 
VO-Command-- 
Select an edge or handle to resize from the Object Resize Options menu, and then resize it 
To resize an edge, use the VO and arrow keys (for example, press VO-Right Arrow to extend the right edge of an object). To resize a handle, use VO and two arrow keys (for example, press VO-Right Arrow-Up Arrow to extend the top right handle of an object). To resize in smaller increments, also press Shift. 
Move an object 
VO-Command-' 
Then use the VO and arrow keys (for example, press VO-Left Arrow to move an object left). To move an object diagonally, use VO and two arrow keys (for example, press VO-Left Arrow-Up Arrow to move an object diagonally left and up). To move in smaller increments, also press Shift. 
Stop scrolling or resizing 
Escape 
Create a custom label 
VO-/ 
Navigation commands 
Use these commands to move around the screen, move inside windows and webpages, and control cursor tracking. 
NOTE:If your keyboard has an Fn key, press the Fn key when you press a function key. ACTION 
�
COMMAND 
Move the VoiceOver cursor up 
VO-Up Arrow 
Move the VoiceOver cursor down 
VO-Down Arrow 
Move the VoiceOver cursor to the left 
VO-Left Arrow 
Move the VoiceOver cursor to the right 
VO-Right Arrow 
Move to the top of the visible area (such as a window or text area) where the VoiceOver cursor is located 
VO-Home 
On some keyboards, press VO-Fn-Left Arrow. 
Move to the bottom of the visible area (such as a window or text area) where the VoiceOver cursor is located 
VO-End 
On some keyboards, press VO-Fn-Right Arrow. 
Move to the top of the area (such as a window or text area) where the VoiceOver cursor is located, scrolling if necessary 
VO-Shift-Home 
On some keyboards, press VO-Shift-Fn-Left Arrow. 
Move to the bottom of the area (such as a window or text area) where the VoiceOver cursor is located, scrolling if necessary 
VO-Shift-End 
On some keyboards, press VO-Shift-Fn-Right Arrow. 
Move to the top of a window, the first item in the Dock, or the first item on your desktop, depending on your location 
VO-Command-Home 
On some keyboards, press VO-Command-Fn-Left Arrow. 
Move to the lower-right corner of a window, the last item in the Dock, or the last item on your desktop, depending on your location 
VO-Command-End 
On some keyboards, press VO-Command-Fn-Right Arrow. 
Move the window containing the VoiceOver cursor to the front, making it the active window VO-Shift-F2 
Close (if possible) the window containing the VoiceOver cursor 
VO-Command-F2 
Open the Item Chooser 
VO-I 
Move to the Dock VO-D 
Move to the desktop 
VO-Shift-D 
Move to the menu bar 
VO-M 
Move to the first status menu in the menu bar 
VO-M-M 
Open the Spotlight menu 
VO-M-M-M 
Open a shortcut menu 
VO-Shift-M 
Jump to a linked item (for example, from a Mail message in the Inbox to its message text) VO-J 
Temporarily disable or enable the cursor tracking options you selected in VoiceOver 
�
Utility 
The command doesn't change the settings in VoiceOver Utility. 
VO-Shift-F3 
Move the VoiceOver cursor to the keyboard focus 
VO-Shift-F4 
Move the keyboard focus to the VoiceOver cursor 
VO-Command-F4 
Move the VoiceOver cursor to the mouse pointer 
VO-Shift-F5 
Move the mouse pointer to the VoiceOver cursor 
VO-Command-F5 
Jump from the current location to any displayed input method or auto correction panel, and then jump back to the original location 
VO-Shift-J 
Find text 
VO-F 
While finding text, cycle through search item history 
VO-Up Arrow or Down Arrow 
Move the VoiceOver cursor in the given direction, wrapping when necessary VO-Command-Shift-arrow keys 
Set or remove a hot spot VO-Shift-[number key] 
Jump to a hot spot 
VO-[number key] 
Hear a description of a hot spot 
VO-Command-[number key] Monitor a hot spot 
VO-Command-Shift-[number key] Open the Hot Spot Chooser VO-[number key]-[number key] Move to the next hot spot VO-] 
Move to the previous hot spot VO-[ 
Jump back to a parent folder VO-Command-\ 
Orientation commands 
Use these commands to hear where the cursors are located and what is open on the screen. NOTE:If your keyboard has an Fn key, press the Fn key when you press a function key. ACTION 
COMMAND 
Hear a summary of open applications 
VO-Fl 
Open the Application Chooser VO-Fl-F1 
Hear a summary of the current window 
VO-F2 
Open the Window Chooser VO-F2-F2 
Describe the item in the VoiceOver cursor 
VO-F3 
Describe the size of the item in the VoiceOver cursor 
VO-Command-F3 
Describe the position of the item in the VoiceOver cursor 
�
VO-Command-F3-F3 
Describe the item that has keyboard focus 
VO-F4 
Describe in more detail the item that has the keyboard focus 
In text, the location of the insertion point (from the upper-left corner of the screen) is provided. 
VO-F4-F4 
Describe the item under the mouse pointer 
VO-F5 
Describe the location of the mouse pointer in x, y coordinates (from the upper-left corner of the screen) 
VO-F5-F5 
Describe the location of the mouse pointer (from the upper-left corner of the window) VO-F5-F5-F5 
Read the selected item 
VO-F6 
Read the contents of the VoiceOver cursor 
VO-A 
Read the visible contents of the window, the Dock, or your desktop, depending on your location 
VO-Shift-W 
Repeat the last spoken phrase 
VO-Z 
Copy the last spoken phrase to the Clipboard (also called the "Pasteboard") 
VO-Shift-C 
Save the last spoken phrase and the crash log to a file on the desktop for troubleshooting VO-Shift-Z 
Search commands 
Use these commands to search for text attributes, graphics, controls, and other items in 
text documents and webpages. 
NOTE:If your keyboard has an Fn key, press the Fn key when you press a function key. 
ACTION 
COMMAND 
Find 
VO-F 
Open the Find Commands menu 
VO-Shift-F 
Find the next searched text 
VO-G 
Find the previous searched text 
VO-Shift-G 
Find the next list 
VO-Command-X 
Find the previous list 
VO-Command-Shift-X 
Find the next bold text 
VO-Command-B 
Find the previous bold text 
VO-Command-Shift-B 
Find the next style change 
VO-Command-C 
Find the previous style change 
VO-Command-Shift-C 
Find the next italic text 
�
VO-Command-I 
Find the previous italic text 
VO-Command-Shift-I 
Find the next color change 
VO-Command-K 
Find the previous color change 
VO-Command-Shift-K 
Find the next font change 
VO-Command-O 
Find the previous font change 
VO-Command-Shift-O Find the next table VO-Command-T 
Find the previous table 
VO-Command-Shift-T 
Find the next underlined text 
VO-Command-U 
Find the previous underlined text 
VO-Command-Shift-U Find the next control VO-Command-J 
Find the previous control 
VO-Command-Shift-J 
Find the next different item 
VO-Command-D 
Find the previous different item 
VO-Command-Shift-D 
Find the next item that's the same type as the current item VO-Command-S 
Find the previous item that's the same type as the current item VO-Command-Shift-S 
Find the next graphic VO-Command-G 
Find the previous graphic 
VO-Command-Shift-G Find the next heading VO-Command-H 
Find the previous heading 
VO-Command-Shift-H Find the next link VO-Command-L 
Find the previous link VO-Command-Shift-L 
Find the next heading of the same level 
VO-Command-M 
Find the previous heading of the same level 
VO-Command-Shift-M 
Find the next plain text 
VO-Command-P 
Find the previous plain text 
VO-Command-Shift-P 
Find the next visited link 
VO-Command-V 
Find the previous visited link 
�
VO-Command-Shift-V 
Find the next misspelled word 
VO-Command-E 
Find the previous misspelled word 
VO-Command-Shift-E 
Find the next blockquote 
VO-Command-Q 
Find the previous blockquote 
VO-Command-Shift-Q 
Find the next blockquote of the same level 
VO-Command-W 
Find the previous blockquote of the same level 
VO-Command-Shift-W 
Text commands 
Use these commands to read and edit text and tables. Before you can use most of these commands, you must interact with text in a text area. 
NOTE:If your keyboard has an Fn key, press the Fn key when you press a function key. ACTION 
COMMAND 
Read the contents of the VoiceOver cursor 
VO-A 
Select all text in the VoiceOver cursor 
VO-Shift-A 
Start and stop text selection in a text field (text selection tracking must be on) VO-Return 
Speak text attributes 
VO-T 
Add a hot spot in text 
VD-Shift-[l-lumber key] 
For example, VO-Shift-1 or VO-Shift-9. 
Jump to a hot spot in text 
VO-[number key] 
For example, VO-1 or VO-9. 
Read the paragraph in the VoiceOver cursor 
VO-P 
Read the next paragraph 
VO-Shift-Page Down 
Read the previous paragraph 
VO-Shift-Page Up 
Read the sentence in the VoiceOver cursor 
VO-S 
Read the next sentence 
VO-Command-Page Down 
Read the previous sentence 
VO-Command-Page Up 
Read the line in the VoiceOver cursor 
VO-L 
Read the next line 
VO-Down Arrow 
Read the previous line 
VO-Up Arrow 
Read the word in the VoiceOver cursor 
VO-W 
Spell alphabetically the word in the VoiceOver cursor 
�
VO-W-W 
Spell phonetically the word in the VoiceOver cursor 
VO-W-W-W 
Read the next word 
VO-Right Arrow 
Read the previous word 
VO-Left Arrow 
Read the character in the VoiceOver cursor 
VO-C 
Read phonetically the character in the VoiceOver cursor 
VO-C-C 
Read the next character 
VO-Shift-Right Arrow 
Read the previous character 
VO-Shift-Left Arrow 
Move to the first visible word 
VO-Home 
On a portable computer, press VO-Fn-Left Arrow. 
Move to the last visible word 
VO-End 
On a portable computer, press VO-Fn-Right Arrow. 
Move to the beginning of text, scrolling if necessary 
VO-Shift-Home 
On a portable computer, press VO-Shift-Fn-Left Arrow. 
Move to end of text, scrolling if necessary 
VO-Shift-End 
On a portable computer, press VO-Shift-Fn-Right Arrow. 
Add new tab stop in TextEdit (the VoiceOver cursor must be on a tab stop in the ruler) VO-Space bar 
Delete the current tab stop in TextEdit (the VoiceOver cursor must be on a tab stop in the ruler) 
VO-Delete 
Interact with tab stop in TextEdit (the VoiceOver cursor must be on a tab stop in the ruler) 
VO-Shift-Down Arrow 
Then use the Left and Right Arrow key to move the stop. 
Reads the current word and character in the VoiceOver cursor 
VO-F3 
Reads the total number of lines and the number of visible lines in a document 
VO-F3-F3 
Web commands 
Use these commands to navigate and interact with webpages. 
NOTE:If your keyboard has an Fn key, press the Fn key when you press a function key. ACTION 
COMMAND 
Move to the next column 
VO-Command-Y 
Move to the previous column 
VO-Command-Shift-Y 
Move to the next frame 
VO-Command-F 
Move to the previous frame 
VO-Command-Shift-F 
Move to the next auto web spot 
�
VO-Command-N 
Move to the previous auto web spot 
VO-Command-Shift-N 
Move to the next web spot 
VO-Command-] 
Move to the previous web spot 
VO-Command-F 
Open the Web rotor VO-U 
Read from the current location on a webpage to the end of the page 
VO-A 
Read from the beginning of a webpage to the current location 
VO-B 
Read a link address (URL) 
VO-Shift-U 
Read the next sentence VO-Command-Page Down 
Read the previous sentence 
VO-Command-Page Up 
Read webpage statistics 
VO-Shift-I 
Remove a web spot VO-Command-Shift-{ Create a web spot VO-Command-Shift-} Set the sweet spot VO-Command-Shift-}-} 
Turn the grouping of items within a table on or off 
VO-= 
VoiceOver standard gestures 
If you're using a Multi-Touch trackpad, you can use VoiceOver gestures. VoiceOver provides a set of standard gestures for navigating and interacting with items on the screen. You can't modify this set of gestures. 
NOTE:If a gesture doesn't mention a specific number of fingers, you use a single finger to perform the gesture. 
ACTION 
GESTURE 
General 
Enable the Trackpad Commander and VoiceOver gestures 
VO-Two-finger rotate clockwise 
Disable the Trackpad Commander and VoiceOver gestures 
VO-Two-finger rotate counterclockwise 
Turn the screen curtain on or off 
Three-finger triple-tap Mute or unmute VoiceOver Three-finger double-tap Navigation 
Force the VoiceOver cursor into a horizontal or vertical line when you drag a finger across the trackpad 
Hold down the Shift key and drag a finger horizontally or vertically 
Move the VoiceOver cursor to the next item 
�
Flick right 
Move the VoiceOver cursor to the previous item Flick left 
Move content or the scroll bar (depending on the Trackpad Commander setting) 
Three-finger flick in any direction 
Go to the Dock 
Two-finger double-tap near the bottom of the trackpad Go to the menu bar 
Two-finger double-tap near the top of the trackpad Open the Application Chooser 
Two-finger double-tap on the left side of the trackpad Open the Window Chooser 
Two-finger double-tap on the right side of the trackpad Jump to another area of the current application 
Press Control while touching a finger on the trackpad Interaction 
Speak the item in the VoiceOver cursor or, if there isn't an item, play a sound effect to indicate a blank area 
Touch (includes tap or dragging) 
Select an item 
Double-tap anywhere 
You can also split-tap (touch one finger and then tap with a second finger) 
Start interacting with the item in the VoiceOver cursor 
Two-finger flick right 
Stop interacting with the item in the VoiceOver cursor 
Two-finger flick left Scroll one page down or up 
Three-finger flick up or down 
Escape (close a menu without making a selection) 
Two-finger scrub back and forth 
Increase or decrease the value of a slider, splitter, stepper, or other control 
Flick up (increase) or flick down (decrease) 
Text 
Read the current page, starting at the top 
Two-finger flick up 
Read from the VoiceOver cursor to the end of the current page Two-finger flick down 
Read the current scroll page 
Three-finger tap 
Pause or resume speaking 
Two-finger tap 
Describe what's in the VoiceOver cursor 
Triple-tap 
Change how VoiceOver reads text (by word, line, sentence, or paragraph) Press Command while touching a finger on the trackpad 
Rotor 
Change the rotor settings 
Two-finger rotate 
Move to the previous item based on the rotor setting Flick up 
Move to the next item based on the rotor setting 
�
Flick down 
To customize other gestures by assigning VoiceOver commands to them, use the Trackpad Commander. 
Assign VoiceOver commands to gestures 
If you need a reminder about what a gesture does, press VO-K to start keyboard help, and then use the gesture to hear the description. 
Learn keys, shortcuts, and gestures with keyboard help 
New and changed VoiceOver commands in Mac OS X Lion 
VoiceOver in Mac OS X Lion (version 10.7) introduces several new and changed commands. NOTE:If your keyboard has an Fn key, press the Fn key when you press a function key. ACTION 
COMMAND 
New 
Mark an item that you want to drag and drop in another location 
VO- 
Drop the marked item after the VoiceOver cursor 
VO-> 
Drop the marked item in front of the VoiceOver cursor 
VO-< 
Drop the marked item on the VoiceOver cursor 
VO- 
Open the Activity Chooser 
VO-X 
Switch to the previous activity 
VO-X-X 
Move to the next hot spot 
VO-] 
Move to the previous hot spot 
VO-[ Changed 
Jump from the current location to any displayed input method window or auto correction panel, and then jump back to the original location 
VO-Shift-J 
Appendix B. VoiceOver Utility Options 
This chapter lists the options on each VoiceOver Utility pane and explains how to use the options 
General category 
Use the General category to specify a login greeting, use portable preferences, and enable AppleScript scripts to control VoiceOver. 
OPTION 
DESCRIPTION 
Login Greeting 
The text VoiceOver speaks when you log in while VoiceOver is on. To change the greeting, type new text over the default text. 
Display welcome dialog when VoiceOver starts 
Select the checkbox to display the welcome dialog each time VoiceOver is turned on. Portable Preferences 
�
VoiceOver indicates whether it detects a portable preferences drive. Click one of these buttons: 
Set Up: To create and use a portable preferences drive. 
Stop: To stop using the detected portable preferences drive. 
Start: To start using the detected portable preferences drive. 
Allow VoiceOver to be controlled with AppleScript 
Select the checkbox to be able to use AppleScript scripts to automate VoiceOver tasks. Speech pane of the Verbosity category 
Use the Speech pane of the Verbosity category to specify the default verbosity level (amount of information you want to receive) and a verbosity level for specific controls—such as applications, checkboxes, or Dock items—and items such as headings, images, or links 
OPTION 
DESCRIPTION 
Default Speech Verbosity 
From the pop-up menu, choose the default verbosity level for items on the screen. Details 
Click the disclosure triangle to display a list of controls for which you can individually set the verbosity level. From a control's Verbosity pop-up menu, choose a verbosity level for the control: Default, Low, Medium, or High. 
To customize or reorder the information VoiceOver reads (for example, to hear Status first), choose Custom from the pop-up menu, and then follow the instructions that appear. You can change the default verbosity level while you're working by using the Verbosity rotor. To display the rotor, press VO-V. 
Braille pane of the Verbosity category 
Use the Braille pane of the Verbosity category to specify the default verbosity level (amount of information you want to receive) for use with a refreshable braille display. You can also specify a verbosity level for specific controls—such as applications, checkboxes, or Dock items—and items such as headings, images, or links. 
OPTION 
DESCRIPTION 
Default Braille Verbosity 
From the pop-up menu, choose the default verbosity level for items on the screen. Details 
Click the disclosure triangle to show or hide a list of controls for which you can individually set the verbosity level. From a control's Verbosity pop-up menu, choose a verbosity level for the control: Default, Low, Medium, or High. 
To customize or reorder the information VoiceOver provides (for example, to hear Status first), choose Custom from the pop-up menu, and then follow the instructions that appear. You can change the default verbosity level while you're working by using the verbosity rotor. To open the rotor, press VO-V. 
Text pane of the Verbosity category 
Use the Text pane of the Verbosity category to customize the amount of punctuation, text, and text attributes you hear, among other options. 
OPTION 
DESCRIPTION 
Punctuation 
From the pop-up menu, choose how much punctuation you want to hear: 
All: Hear all special symbols and punctuation except for spaces. VoiceOver reads a sentence like this, "She turned and stopped comma then started walking again period" Most: Hear all special symbols but not common punctuation, such as the comma and period. Some: Hear keyboard symbols and many math symbols, such as + (plus) sign. 
None: Hear text as you would normally read it, with pauses for commas and periods. 
�
Repeated Punctuation 
From the pop-up menu, choose how you want to hear repeated punctuation: always or a specific number of times. 
While typing speak 
From the pop-up menu, choose what you want to hear while typing (called the "typing 
echo"): Characters, Words, Characters and Words, or Nothing. 
When moving the cursor 
From the pop-up menu, choose how you want to hear text when moving the VoiceOver cursor: "Speak text the cursor passes" or "Speak text to the right of the cursor." 
When text attributes change 
From the pop-up menu, choose how you want to hear changes in text attributes: Do Nothing, Play Tone, or Speak Attributes. 
When encountering a misspelled word 
Choose how you want to hear misspelled words: 
Do Nothing: Hear the word. 
Play Tone: Hear a sound effect. 
Speak Attributes: Hear "misspelled" and then the word. 
Change Pitch: Lower the pitch. When encountering a link 
From the pop-up menu, choose how you want to hear links: 
Speak Link: Hear "link" and then the link text. 
Change Pitch: Hear the link text in a different voice pitch than unlinked text. 
Play Tone: Hear a sound effect. Do Nothing: Hear the link text. Read numbers as 
From the pop-up menu, choose how you want to hear numbers: Words or Digits. 
When reading a capital letter 
From the pop-up menu, choose how you want to hear uppercase letters or words that start with uppercase letters, depending on your settings for typing echo: 
Change Pitch: Hear the letter or word in a different voice pitch than lowercase text. 
Play Tone: Hear a sound effect. 
Speak Cap: Hear "cap" and then the letter or word. 
Do Nothing: Hear the letter or word. When deleting text 
From the pop-up menu, choose how you want to hear text that you're deleting: 
Change Pitch: Hear the text you're deleting in a different voice pitch than other text. Play Tone: Hear a sound effect. 
Speak: Hear "deleting" and then the text you're deleting. 
Do Nothing: Hear the text you're deleting. 
Words are separated by 
From the pop-up menu, choose how you want to hear word separations: "Punctuation and whitespace" or Whitespace. 
Announcements pane of the Verbosity category 
Use the Announcements pane of the Verbosity category to specify when you want VoiceOver to announce certain events, such as when a modifier key is pressed, and when to speak certain text, such as labels in dialogs. 
OPTION 
DESCRIPTION 
Announce when mouse cursor enters a window 
Select the checkbox to hear when the mouse pointer goes to a window. This setting is useful if you're using the mouse pointer independently of the VoiceOver cursor and keyboard focus. 
Announce when a modifier key is pressed 
Select the checkbox to hear when you press a modifier key. This setting is useful while 
�
you're still learning VoiceOver commands and want to confirm the keys you're pressing. Announce when the Caps Lock key is pressed 
Select the checkbox to hear when you press the key that makes all letters uppercase. This setting is useful if you press the key inadvertently and are typing everything in uppercase. 
Speak header when navigating across a table row 
Select the checkbox to hear header text in a table row. This setting is useful for identifying the type of content in a row. 
Automatically speak text in dialog boxes 
Select the checkbox to hear labels and other text in dialogs. 
Use phonetics 
Select the checkbox to always hear characters read phonetically. For example, if VoiceOver is reading text by character, it reads "a alpha n november t tango." 
When status text changes under VoiceOver cursor 
From the pop-up menu, choose how you want to hear changes in status text (such as the percentage complete of a software installation): Play Tone, Speak Text, or Do Nothing. When progress indicator changes under VoiceOver cursor 
From the pop-up menu, choose how you want to hear progress indicator changes: Play Tone, Speak Update, or Do Nothing. 
Speak size and position in 
From the pop-up menu, choose how you want to hear size and position: Inches, Millimeters, or Pixels. 
Speak text under mouse after delay 
Drag the slider toward Short or Long to specify how many seconds you want VoiceOver to wait before it speaks the text that's under the mouse pointer. 
Hints pane of the Verbosity category 
Use the Hints pane to have VoiceOver provide more information about the item in the VoiceOver cursor. 
OPTION 
DESCRIPTION 
Speak instructions for using the item in the VoiceOver cursor 
Select the checkbox to have VoiceOver automatically read instructions, if available, for the item. 
When an item has a help tag 
From the pop-up menu, choose how you want to hear the descriptions (called "help tags" or "tooltips") that are displayed when the pointer rests briefly over an item: Do Nothing, Speak Notification, or Speak Help Tag (the default setting). 
Speak hints after delay 
Drag the slider toward Short or Long to set how many seconds VoiceOver waits before it speaks the hint for the item under the mouse pointer. 
Voices pane of the Speech category 
Use the Voices pane of the Speech category to mute speech and customize voice settings. OPTION 
DESCRIPTION 
Mute Speech 
Select the checkbox to turn off VoiceOver speech. This option doesn't affect VoiceOver sound effects or the audio of other applications. 
Voice 
From the pop-up menu, choose a default voice for VoiceOver, such as Alex. 
To add compact or premium voices to the pop-up menu, choose Customize, and then select the voices. When you select some voices, a yellow triangle appears, indicating those voices must be downloaded before they can appear in the menu. 
Rate 
Click the up or down arrow on the stepper to set the speed at which a voice speaks. 
�
Pitch 
Click the up or down arrow on the stepper to set how high or low a voice speaks. 
Volume 
Click the up or down arrow on the stepper to set how loudly or softly a voice speaks. Intonation 
Click the up or down arrow on the stepper to set how a voice rises and falls as it speaks. Disclosure triangle 
Click the triangle to choose different voices for specific items, such as status or attributes. 
Pronunciation pane of the Speech category 
Use the Pronunciation pane of the Speech category to customize how VoiceOver pronounces text and symbols. 
OPTION 
DESCRIPTION Text 
Lists the words, acronyms, or symbols for which you have specified a pronunciation. 
To change an item listed in the Text column, navigate to it and press VO-Space bar. Substitution 
Lists the pronunciations you have specified. 
To change an item listed in the Substitution column, navigate to it and press VO-Space bar. 
Application 
Lists applications where you want VoiceOver to use the custom pronunciation. 
To change the application, choose a different application (or All Apps) from the pop-up menu. The pop-up menu lists only applications that are currently open. 
Ignore Case 
Select the checkbox to ignore capitalization. If VoiceOver is set to indicate capitalization when speaking, you might want to ignore uppercase and lowercase in your pronunciations. 
Add (+) 
Click Add to add a substitution to the list. 
Remove (-) 
Click Remove to remove the selected substitution from the list. 
Navigation category 
Use the Navigation category to customize navigation settings, such as those related to using the VoiceOver cursor, automatically interacting with items, and fast searching. OPTION 
DESCRIPTION 
Initial position of VoiceOver cursor 
From the pop-up menu, choose the initial position of the VoiceOver cursor in a new window: "Keyboard focused item" or "First item in window." 
Keyboard focus follows VoiceOver cursor 
Select the checkbox to make the keyboard focus follow wherever the VoiceOver cursor goes whenever possible. 
VoiceOver cursor follows keyboard focus 
Select the checkbox to make the VoiceOver cursor follow wherever the keyboard focus goes. When this option and the previous option are selected, VoiceOver cursor tracking is on. Insertion point follows VoiceOver cursor 
Select the checkbox to make the insertion point follow wherever the VoiceOver cursor goes. VoiceOver cursor follows insertion point 
Select the checkbox to make the VoiceOver cursor follow wherever the insertion point goes. Mouse pointer 
From the pop-up menu, choose how you want the mouse pointer to follow the VoiceOver 
cursor: "Ignores VoiceOver cursor," "Follows VoiceOver cursor," or "Moves VoiceOver 
�
cursor." 
The default setting is "Ignores VoiceOver cursor." 
Allow cursor wrapping 
Select the checkbox to wrap the VoiceOver cursor up, down, left, and right in a continuous loop when you're navigating. 
Skip redundant labels 
Select the checkbox to hear duplicate labels only once. 
Automatically interact when using tab key 
Select the checkbox to be able to use VoiceOver to interact with items you tab to without first having to use VO-Shift-Down Arrow. 
Enable fast searching 
Select the checkbox to be able to quickly search for the next or previous element on the screen that begins with a specified letter. From the pop-up menu, choose whether to use the Left Command key or the Right Command key for fast searching. 
For example, to search for the next element that begins with the letter S, you could press Left Command-S. To search for the previous element, you could press Left Command-Shift-S. Navigation pane of the Web category 
Use the Navigation pane of the Web category to set options related to navigating and browsing webpages. 
OPTION 
DESCRIPTION 
Navigate webpages by 
Select a method for navigating webpages: 
DOM order: Move the VoiceOver cursor through a webpage based on the page's Document Object Model (DOM). Navigating by DOM moves left and right, in the order the webpage's author intended. (Moving up and down in DOM mode is based on the current setting of the Web Item rotor.) 
Grouping items: Move the VoiceOver cursor from one group of information to the next, such as from one paragraph to the next paragraph. Navigating by group moves in any direction, to help give you a sense of context. 
Group items within 
Select the checkbox to hear a summary of a table and a summary of each cell as you navigate the table using the arrow keys. This option is useful if you're familiar with a table and don't need to read its contents. If you do want to read the contents of a cell, you must interact with it using VoiceOver commands. 
When the checkbox isn't selected, you automatically interact with a table and read its contents, cell by cell, as you navigate the table using the arrow keys. 
Speak column and row numbers 
Select the checkbox to have VoiceOver speak the column and row numbers in tables to help you navigate complex tables more easily. This option is on by default. 
Navigate images 
From the pop-up menu, choose how you want VoiceOver to navigate images: Never, With Descriptions, or Always. 
By default, VoiceOver navigates only to images that contain a description, called "alt text." This option is useful because many websites use images for links. 
Enable Live Regions 
Select the checkbox to have VoiceOver speak all live regions it encounters on webpages. If you prefer to hear only specific live regions, deselect the checkbox and then use the Web rotor to find and enable specific live regions on a webpage. 
Page Loading pane of the Web category 
Use the Page Loading pane of the Web category to specify what you want to happen while a new webpage is being displayed. 
OPTION 
DESCRIPTION 
�
Speak webpage summary 
Select the checkbox to have VoiceOver speak a summary (statistics) of the items on a webpage when the page opens. The summary is based on the items included in the Web rotor. For example, if the rotor includes headers, links, auto web spots, and form controls, the webpage summary that VoiceOver speaks might sound like "The Apple - Accessibility page has 14 headers 52 links 8 auto web spots 1 form control." 
Move the VoiceOver cursor to it 
Select the checkbox to position the VoiceOver cursor on the first item or the sweet spot (if one exists) in the webpage when the webpage opens. 
Automatically speak the webpage 
Select the checkbox to have VoiceOver start speaking a webpage when the page opens. If you set a sweet spot on the page, VoiceOver starts reading from the sweet spot; otherwise, it starts reading from the beginning of the page. 
This option is available only if you've selected the previous option to move the VoiceOver cursor to the first item or sweet spot. 
While a webpage loads 
From the pop-up menu, choose what you want to hear while a webpage is being displayed: Speak Progress, Play Tone, or Do Nothing. 
By default, VoiceOver speaks the percentage of the webpage that is loaded. 
Web Rotor pane of the Web category 
Use the Web Rotor pane of the Web category to specify which items to include, and in what order, in the Web rotor. 
OPTION 
DESCRIPTION 
Item Order 
The list of items you can include in the Web rotor. 
Select a checkbox to include an item in the rotor; deselect a checkbox to exclude an item from the rotor. You can reorder items in the list so the items you use most will appear first in the rotor. 
Sound category 
Use the Sound category to set options related to sound effects and positional audio. OPTION 
DESCRIPTION 
Mute sound effects 
Select the checkbox to turn off VoiceOver sound effects. This option doesn't affect VoiceOver speech or the audio of other applications. 
Enable positional audio 
Select the checkbox to add audio cues that help you locate items on the screen. The cues play in stereo; you need a pair of earbuds or stereo headphones, or standard stereo speakers, to hear them. Positional audio is on by default. 
Output Device 
From the pop-up menu, choose the device you want to use to output sounds. This option is most useful if you have connected to your computer an audio output device, such as headphones or speakers. 
VoiceOver Cursor pane of the Visuals category 
Use the VoiceOver Cursor pane of the Visuals category to set options related to the VoiceOver cursor. 
OPTION 
DESCRIPTION 
Show VoiceOver cursor 
Select the checkbox to show the VoiceOver cursor (the default setting). The VoiceOver cursor appears as a dark outlined box. 
VoiceOver Cursor Magnification 
Drag the slider toward Small or Large to decrease or increase the size of the VoiceOver 
�
cursor 
When reading text, move VoiceOver cursor by 
From the pop-up menu, choose how the VoiceOver cursor should move while reading: Sentence or Word. 
Caption Panel pane of the Visuals category 
Use the Caption Panel pane of the Visuals category to customize the size and appearance of the caption panel. 
OPTION DESCRIPTION 
Show caption panel 
Select the checkbox to display the caption panel. 
Caption Panel Font Size 
Drag the slider toward Small or Large to set the font size in the caption panel. 
Rows in Caption Panel 
Drag the slider toward 1 or 10 to remove or add rows, changing the height of the panel. Caption Panel Transparency 
Drag the slider toward 0 percent or 100 percent to decrease or increase the panel's transparency. If you increase the transparency, the panel's background color becomes lighter and you can more easily see the screen behind the panel. 
Braille Panel pane of the Visuals category 
Use the Braille Panel pane of the Visuals category to customize the appearance of the braille panel. 
OPTION DESCRIPTION 
Show Braille Panel 
From the pop-up menu, choose how you want to display the braille panel: Off, On, or Automatic. When set to the default setting, Automatic, the braille panel is displayed when you connect a refreshable braille display to your computer. 
Braille Font Color 
From the pop-up menu, choose a color for displaying text in the braille panel. 
Braille Panel Font Size 
Drag the slider toward Small or Large to set the font size in the braille panel. 
Braille Panel Transparency 
Drag the slider toward 0 percent or 100 percent to decrease or increase the panel's transparency. If you increase the transparency, the panel's background color becomes lighter and you can more easily see the screen behind the panel. 
Touch pane of the Visuals category 
Use the Touch pane of the Visuals category to customize the transparency of the background that dims the screen around the focus area. 
This pane is available only when you're using a Multi-Touch trackpad. 
OPTION DESCRIPTION 
Background Transparency 
Drag the slider toward 0 percent or 100 percent to decrease or increase the transparency of the dimmed background around the focus area. If you increase the transparency, the background color becomes lighter and you can more easily see the rest of the screen. 
Menus pane of the Visuals category 
Use the Menus pane of the Visuals category to customize the appearance of VoiceOver menus, such as the Commands menu or Web menu. 
OPTION DESCRIPTION 
VoiceOver Menus Font Size 
Drag the slider toward Small or Large to set the font size used in VoiceOver menus. VoiceOver Menus Transparency 
�
Drag the slider toward 0 percent or 100 percent to decrease or increase the transparency of the menus. If you increase the transparency, a menu's background color becomes lighter and you can more easily see the screen behind the menu. 
Trackpad pane of the Commanders category 
Use the Trackpad pane of the Commanders category to enable the Trackpad Commander and set other options for using VoiceOver gestures. 
This pane is available only when VoiceOver detects a Multi-Touch trackpad. OPTION 
DESCRIPTION 
Enable Trackpad Commander 
Select the checkbox to use standard VoiceOver gestures and assign VoiceOver commands to other gestures. 
Automatically select items in lists and tables 
Select the checkbox to have VoiceOver automatically select the list or table item you're touching when you lift your finger from the trackpad. 
If you don't want VoiceOver to select an item, drag your finger off the list or table before lifting your finger. 
Pause speech when not touching the trackpad 
Select this checkbox to have VoiceOver pause speech when you lift your finger off the trackpad while dragging. For example, if you're dragging a finger to navigate lines of text and you lift your finger, VoiceOver pauses speech. 
Scroll gesture moves content instead of scroll bar 
Select this checkbox to scroll the content (not the scroll bar) down or up. Normally when you move the scroll bar down or up, the content moves in the opposite 
direction. When this option is selected, the content moves in the same direction you're scrolling. 
Assign Commands 
Click the button to display the pane in which you assign VoiceOver commands to gestures. When the Trackpad Commander is on, the Trackpad Commander commands are included in the Commands menu. To display the Commands menu, press VO-H-H. 
Find commands using the Commands menu 
Trackpad Commander assignments pane 
Use the Trackpad Commander assignments pane to assign VoiceOver commands to trackpad gestures. 
OPTION 
DESCRIPTION 
Modifier pop-up menu 
From the pop-up menu, choose the modifier key you want to use with gestures. By default, no modifier is used. 
Trackpad Gesture 
Indicates the gestures you can assign VoiceOver commands to. 
Command 
Click the command field to display pop-up menus for the different types of commands you can assign to a gesture. 
NumPad pane of the Commanders category 
Use the NumPad pane of the Commanders category to enable the NumPad Commander and assign VoiceOver commands to numeric keypad keys. 
OPTION 
DESCRIPTION 
Enable NumPad Commander 
Select the checkbox to enable the NumPad Commander. 
When the NumPad Commander is enabled, you can't use Mouse Keys, a Universal Access feature in Mac OS X. 
Modifier pop-up menu 
�
From the pop-up menu, choose a modifier key to increase the number of numeric keys you can assign VoiceOver commands to. 
Numpad Key 
Indicates the numeric keypad key you've assigned a VoiceOver command to. 
Command 
Indicates the VoiceOver command currently assigned to a numeric keypad key. 
Click the current command to display pop-up menus for the different types of commands you can assign to a key. 
Keyboard pane of the Commanders category 
Use the Keyboard pane of the Commanders category to enable the Keyboard Commander and assign VoiceOver commands to key combinations that might be easier for you to remember or perform. 
OPTION 
DESCRIPTION 
Enable Keyboard Commander 
Select the checkbox to enable the Keyboard Commander so you can assign VoiceOver commands to keyboard keys. 
Use 
From the pop-up menu, select the key you want to use as the designated Keyboard Commander modifier: Right Option Key, Left Option Key, or Both Option Keys. 
Keyboard Key 
Double-click a key and type a new key to assign to the VoiceOver command that's displayed. Command 
From the pop-up menus, choose a different command to assign to a key. 
Add (+) 
Click Add to add a key to the list. Type the key and then choose a VoiceOver command to assign to it from the Command pop-up menu. 
Remove (-) 
Click Remove to delete a key from the list. 
Quick Nav pane of the Commanders category 
Use the Quick Nav pane to enable and set options for using Quick Nav, and to assign VoiceOver commands to single keys (instead of key combinations) for navigating webpages using Quick Nay. 
OPTION 
DESCRIPTION 
Enable Quick Nav 
Select the checkbox to turn Quick Nav on or off. 
Allow toggling of Quick Nav using left and right arrow keys 
Select the checkbox to be able to turn Quick Nav on or off while working by pressing the Left Arrow and Right Arrow keys at the same time. 
Enable single-key webpage navigation when using Quick Nav 
Select the checkbox to enable the use of Quick Nav single-key commands while viewing webpages. To customize the single-key commands, click Assign Commands. 
Assign Commands 
Click the button to display the pane in which you assign VoiceOver commands to arrow and letter keys on the keyboard. 
Quick Nav Commander assignments pane 
Use the Quick Nav assignments pane to assign VoiceOver commands to single keys for use when navigating webpages using Quick Nay. 
OPTION 
DESCRIPTION 
Command type 
From the pop-up menu, choose Arrows or Single Keys. 
Single Key 
�
Indicates the single key to which a VoiceOver command is assigned. 
Command 
Indicates the VoiceOver command currently assigned to a single key. 
Click the current command to display pop-up menus for the different types of commands you can assign to a key. 
Add (+) 
Click Add to add a key to the list. Type the key and then choose a VoiceOver command to assign to it from the pop-up menus. 
Remove (-) 
Click Remove to delete a key from the list. 
Layout pane of the Braille category 
Use the Layout pane of the Braille category to customize settings for a braille display connected to or paired with your computer. 
OPTION 
DESCRIPTION 
Braille Display 
VoiceOver indicates the braille display it detects. 
Braille Translation 
From the pop-up menu, choose a translation language to use for showing output. Show contracted braille 
Select the checkbox to show output in contracted braille. By default, VoiceOver shows output in uncontracted braille. 
When using contracted braille, VoiceOver automatically uncontracts the word in the VoiceOver cursor so you can edit it more precisely, and then contracts the word when the VoiceOver cursor leaves it. 
Show eight-dot braille 
Select the checkbox to use eight-dot braille (uncontracted) if the primary braille display supports it. This option is selected by default. 
If you also select the "Show contracted braille" checkbox, VoiceOver ignores the eight-dot braille, even if your display supports it, and shows contracted braille instead. Make sure the "Show contracted braille" checkbox is not selected if you want to use eight-dot braille. 
Use dots 7 and 8 to indicate cursor 
Select the checkbox to raise dots 7 and 8 to indicate the position of the VoiceOver cursor. 
This option is selected by default. 
Status cells 
Select checkboxes for the status cells you want to use. 
Show general display status: Show information about the direction in which to pan the current line, and about announcements. 
Show text style: Show common text styles, such as bold or italic font. 
Show extended text style: Show less common text styles, such as strikethrough or superscript. 
Show status on the 
Select a radio button to use cells to the left (the default) or right of the braille line as the status cells. 
Change this setting only if your braille display doesn't provide dedicated status cells. Display alert messages 
Drag the slider all the way to the left, to Off, to not display alert messages. To set the speed with which alerts are displayed, drag the slider between Fast (toward the left) or Slow (all the way to the right). 
Displays pane of the Braille category 
Use the Displays pane of the Braille category to view a list of the refreshable braille  displays connected to or paired with your computer, and to assign VoiceOver commands to 
�
keys on the braille displays. 
OPTION 
DESCRIPTION 
Display list 
VoiceOver lists the braille displays it has detected. 
The list indicates the primary device and disconnected devices, as well as devices physically connected to your computer (USB symbol) and Bluetooth devices paired with your computer (Bluetooth symbol). 
Display information 
VoiceOver shows information about the display selected in the list, such as the number of cells and status cells. 
Primary braille display 
Select the checkbox in the Display information section to use the selected braille display as the primary display for mirroring. 
Assign Commands 
Click the button to assign VoiceOver commands to keys on your braille display. Add (+) 
Click Add to set up a Bluetooth braille display to use with VoiceOver. You can use one Bluetooth braille display at a time. 
Remove (-) 
Click Remove to delete a Bluetooth braille display from the list. 
Allow input from 
From the pop-up menu, choose the displays from which the selected display should accept input: Primary braille display, All braille displays, or No braille displays. 
To accept input only from the primary display, and prevent input from each braille display that's connected to your computer, choose "Primary braille displays." For example, if you're in a classroom setting where students' braille displays are connected to the computer, you can prevent accidental input from those displays, accepting input only from the instructor's display. 
For some Bluetooth braille displays, after you turn off the braille display and move it out of range of your computer, wait for 30 seconds or longer to ensure your computer indicates the braille display is no longer connected. Your Mac tries to maintain the connection during this interval in case the braille display was accidentally turned off or moved out of range. 
When you turn on a paired Bluetooth braille display and move it in range of your computer, your computer should detect it in about five seconds. 
Activities category 
Use the Activities category to set up activities and customize VoiceOver settings for specific uses. 
OPTION 
DESCRIPTION 
Activities list 
Select an activity to display or change its settings. When creating an activity, type its name in the list. 
Settings 
Click a setting's checkbox to include the setting in the activity. 
Three settings are listed: Verbosity, Voices, and Hot Spots. To list additional settings, click the disclosure triangle located to the far right of Hot Spots. To hide them, click it again. 
Set 
Click the Set button for a setting to customize options. 
Select Apps 
Click this button to browse for and choose an application to associate with the activity. When you associate an application with an activity, the activity is automatically used 
�
whenever you open the application. An application can be associated with only one activity at a time. 
Add (+) and Remove (-) 
Click Add to set up a new activity, or click Remove to delete an activity from the list. Duplicate Activity 
Choose this command from the Action pop-up menu (looks like a gear) to create a duplicate of the currently selected activity. This command is a fast way to create an activity that differs only slightly from an existing activity (for example, only the voice differs). 
If you duplicate an activity that has an application associated with it, the association is not duplicated; an application can be associated with only one activity at a time. Reset Activity to My Current VoiceOver Settings 
Choose this command from the Action pop-up menu (looks like a gear) to change the selected activity to have the same settings as you've specified throughout VoiceOver Utility. This command is useful if you don't like how you've customized an activity and want to start over with settings that match all of your current VoiceOver settings. 
Reset Activity to VoiceOver Default Settings 
Choose this command from the Action pop-up menu (looks like a gear) to change the selected activity to have the default VoiceOver settings. 

